
CHAPTER 01  ഡിസൈനിങിന്റെ ലോകത്തേക്ക് 

1) ഇങ്ക്സ്കേപ്പില്‍ തയാറാക്കിയ  പോസ്റ്ററിലേക്ക് ഒരുചിത്രം ഉള്‍പ്പെടുത്തണം.  വലുതാക്കിയാല്‍ വ്യക്തത കുറയാത്ത 
ചിത്രം ആയിരിക്കണം. ചുവടെ നല്‍കിയിരിക്കുന്നതില്‍ എത് ചിത്രമാണ് അനുയോജ്യം?  

a) image.jpg b )image.svg c)image.png  d ) image.bmp

2) ഇങ്ക്സ്കേപ്പ് ക്യാന്‍വാസില്‍ ഉള്‍പ്പെടുത്തിയ രണ്ട് ഒബ്‌ജക്ടുകളില്‍ പിറകിലുള്ള ഒബ്‍‌ജക്ടിനെ മുന്‍പില്‍ 
എത്തിക്കുന്നതിന് സഹായിക്കുന്ന സങ്കേതം ഏത്?

A)   Raise B) Below C) Up  D) Down 

3) ഇങ്ക്സ്കേപ്പ് ക്യാന്‍വാസില്‍ ഉള്‍പ്പെടുത്തിയ ഒരു ഒബ്‌ജക്ടിന് നല്‍കിയിരിക്കുന്ന നിറത്തിന്റെ കടുപ്പത്തിന് 
വ്യത്യാസം വരുത്തണം. ഇതിന്  ഉപയോഗിക്കാവുന്ന  സങ്കേതം  ഏത്?

A  Flat color B Opacity  C Path D Offset

4) ഇങ്ക്സ്കേപ്പ്  സോഫ്റ്റ്‌വെയറില്‍   Fill and Stroke ജാലകത്തിലെ Stroke paint ടാബ് ഉപയോഗിച്ച് താഴെ 
പറയുന്നവയില്‍ എത് പ്രവര്‍ത്തനമാണ് ചെയ്യാന്‍ സാധിക്കുക?

A  ഒബ്‌ജക്ടിന് നിറം നല്‍കാം

B ഒബ്‌ജക്ടിന്റെ നിറം ഒഴിവാക്കാം

C ഒബ്‌ജക്ടിന്റെ പരിധിക്ക് നിറം നല്‍കാം

D ഒബ്‌ജക്ടിന്റെ സ്റ്റൈല്‍ മാറ്റാം

5) താഴെ പറയുന്നവയില്‍ വെക്ടര്‍ ഇമേജ് ഫയല്‍ എതാണ് ?

A.  Circle.png B. Circle.jpg C. Circle.svg D. Circle.gif

6)  ഇങ്ക്സ്കേപില്‍ തയാറാക്കുന്ന ഒരു പോസ്റ്ററിലേക്ക്  അനു image.png എന്ന ചിത്രത്തെ ഉള്‍പ്പെടുത്തി വലുതാക്കി. 
ആ ചിത്രത്തെ സംബന്ധിച്ച് ചുവടെ നല്‍കിയിരിക്കുന്ന പ്രസ്താവനകളില്‍ ശരിയായത് ഏത്?

A വലുപ്പം കൂടുന്തോറും വ്യക്തതക്ക് 
മാറ്റം വരുന്നില്ല.

B വലുപ്പം കൂടുന്തോറും വ്യക്തത കുറയുന്നു. 

C വലുപ്പം കൂടുന്തോറും വ്യക്തത കൂടുന്നു. 



D മുകളില്‍ നല്‍കിയ മൂന്നു പ്രസ്താവനകളും
 തെറ്റാണ്.            

7) ഇങ്ക്സ്കേപ്പില്‍ ഒന്നില്‍ കൂടുതല്‍ ചിത്രങ്ങളെ ചേര്‍ത്ത് ഒരു യൂണിറ്റാക്കി മാറ്റാന്‍ ചുവടെ നല്‍കിയതില്‍ ഏതു 
സങ്കേതമാണ് അനുയോജ്യം?

A Clip  B Mask C       Transform D Group

8) ഇങ്ക്സ്കേപ്പില്‍ വരച്ച  ചിത്രത്തെ ക്യാന്‍വാസ് സൈസില്‍ തന്നെ  എക്സ്പോര്‍ട്ട് ചെയ്യുന്നതിന് എക്സ്പോര്‍ട്ട് 
ജാലകത്തില്‍ സെലക്‌ട് ചെയ്യേണ്ട അനുയോജ്യമായ ഓപ്ഷന്‍ ഏത് ?

A  Page  B Drawing C Selection D Custom

10) ഇങ്ക്സ്കേപ്പില്‍ തയാറാക്കിയ ചിത്രത്തില്‍ ഒരു ടെക്‌സ്റ്റ് കമാനാകൃതിയില്‍ ഉള്‍പ്പെടുത്തണം. അതിനായി 
ടെക്‌സ്റ്റും അര്‍ദ്ധവൃത്താകൃതിയുള്ള ഒബ്‌ജക്ടും തയ്യാറാക്കി. ചുവടെ നല്‍കിയതില്‍ ഏതു ഒപ്ഷനാണ് 
ഇതിനായി ഉപയോഗിക്കേണ്ടത് ?

A Text → Text and Font. 

B Text → Put on Path 

C Text → Remove from Path

D Text → Convert to Text.

10) ഇങ്ക്സ്കേപ് സോഫ്റ്റ്‌വെയറിന്റെ ടൂള്‍ ബോക്സില്‍ കാണുന്ന ഒരു ടൂളാണ്  ചിത്രത്തില്‍.  ഇതിന്റെ ഉപയോഗമെന്ത്  ?

A. ചതുരം വരക്കാന്‍

B. വൃത്തം വരക്കാന്‍

C. നോഡ് എഡിറ്റ് ചെയ്യാന്‍

D. അക്ഷരങ്ങള്‍ ഉള്‍പ്പെടുത്താന്‍

11) ഇങ്ക്സ്കേപില്‍ തയാറാക്കിയ ഒരു വൃത്തത്തെ  നിഴലും വെളിച്ചവും കാണിക്കുന്ന രീതിയില്‍ നിറം നല്‍കി ഒരു 
ഗോളമാണെന്ന പ്രതീതി ജനിപ്പിക്കാന്‍ സഹായിക്കുന്ന  സങ്കേതം ഏത് ?

A.  Blur B. Fill C. Opacity D. Gradient

12) 

ഇങ്ക്സ്കേപില്‍ ഒരു ചായക്കപ്പ് വരക്കുന്നതിന്റെ 3 ഘട്ടങ്ങളാണ് മുകളിലുള്ളത്. ഇതില്‍ മൂന്നാമത്തെ രൂപം നിര്‍



മ്മിക്കാനായി രണ്ടാമത്തെ രൂപത്തില്‍ ചെയ്ത പ്രവര്‍ത്തനമേത് ?

A. Object ⟶ Group

B. Fill and Stroke ⟶ Opacity

C. Path   ⟶     Difference  

D. Edit ⟶Duplicate

13) ഇങ്ക്സ്കേപില്‍ വരച്ച രണ്ട് ചിത്രങ്ങളാണ് മുകളിലുള്ളത്. ഇതില്‍ ആദ്യ ചിത്രത്തിന് മാറ്റം വരുത്തി  
രണ്ടാമത്തേതു പോലെയാക്കണം. ചുവടെ നല്‍കിയതില്‍ ഏതു സങ്കേതമാണ് ഇതിന് അനുയോജ്യം?

A. Object  ⟶ Group

B. Fill and Stroke  ⟶  Blur  

C. Path ⟶Difference

D. Edit ⟶Duplicate

14) ചിത്രഫയലുകളെ സംബന്ധിച്ച് ചുവടെ കൊടുത്തിരിക്കുന്നവയില്‍ ശരിയായ പ്രസ്താവന ഏത്?

A svg   ചിത്രങ്ങള്‍ വെക്‌ടര്‍ ചിത്രങ്ങളാണ്  .   

B വെക്ടര്‍ ചിത്രങ്ങള്‍ സ്കെയില്‍ ചെയ്യുമ്പോള്‍ 
വ്യക്തത നഷ്ടപ്പെടുന്നു.

C ബിറ്റ് മാപ്പ് ചിത്രങ്ങളെ വെക്‌ടര്‍ ചിത്രങ്ങള്‍ 
എന്നും പറയാം.

D svg ചിത്രങ്ങള്‍ റാസ്റ്റര്‍ ചിത്രങ്ങളാണ്. 

15)  ഇങ്ക്സ്കേപ്പ് സോഫ്റ്റ്‌വെയറില്‍ കളര്‍ പാലറ്റ് ഉപയോഗിച്ച് ഒരു ഒബ്‌ജെക്ടിന്റെ Stroke ന് നിറം നല്‍കാനായി 
മൗസ് ക്ലിക്കിനൊപ്പം ഉപയോഗിക്കുന്ന കീ എതാണ് ?

A  Shift B Space C Tab D F1

16) ചിത്രഫോര്‍മാറ്റുകളുമായി ബന്ധപ്പെട്ട്  SVG എന്നതിന്റെ പൂര്‍ണരൂപം എന്ത് ?

A  Stable Vector Graphics

B Scalable Virtual Graphics

C Steady Vector Graphics

D Scalable Vector Graphics

17)  ചുവടെ ചേര്‍ത്തിരിക്കുന്നവയില്‍നിന്നും വെക്ടര്‍ ഇമേജ് എഡിറ്റിങ്ങ് സോഫ്റ്റ്‌വെയര്‍ കണ്ടെത്തുക.



A GIMP

B   Tux paint

C  Xpaint

D  Inkscape

18) ഒരു ചായക്കപ്പിന്റെ ചിത്രം വരക്കുവാനായി ഇങ്ക്സ്കേപ്പ് കാന്‍വാസില്‍
ലംബമായ ഒരു ദീര്‍ഘവൃത്തവും അതിനു മുകളില്‍ മറ്റൊരു വൃത്തവും വരച്ചു. 

ഇവയില്‍ വൃത്തഭാഗത്തിനെ ഒഴിവാക്കി, ദീര്‍ഘവൃത്തത്തിനെ ഒരു കപ്പിന്റെ
രൂപത്തിലാക്കണം. ചുവടെ നല്‍കിയിരിക്കുന്ന ഏത്  സങ്കേതത്തിലൂടെ ഇതു
സാധ്യമാവും?

A Path   →     Difference  

B   Path → Union

C  Path → Raise

D  Path → Group

19) ഇങ്ക്സ്കേപില്‍ തയാറാക്കിയ ഒരു ചിത്രം png ഫോര്‍മാറ്റിലേക്ക്  സേവ് ചെയ്യുന്നതിനുള്ള പ്രവര്‍ത്തനക്രമം ചുവടെ
നല്‍കിയവയില്‍ നിന്ന് തിരഞ്ഞെടുക്കുക.

A. File → Save As

B. File   →        Export PNG Image  

C. File → Import Clip Art

D. File → Save a Copy

20) ചുവടെ നല്‍കിയിരിക്കുന്നവയില്‍ സ്വതന്ത്ര വെക്ടര്‍ ഇമേജ് എഡിറ്റിങ്ങ് സോഫ്റ്റ്‌വെയര്‍ ഏത് ?

A. ലിബര്‍ഓഫീസ് ഡ്രോ

B. അഡോബ് ഇല്ലസ്ട്രേറ്റര്‍

C. കോറല്‍ ഡ്രോ

D. ജിമ്പ്



STANDARD 10 – UNIT 2:പ്രസിദ്ധീകരണത്തിലേ�ക്ക്

QUESTIONS AND ANSWERS

1. ഒരു ടെ�ക ്സ്റ്റ് ഡ
ോക്യുടെ
ന്റിടെന്റ ഡ�ജും ഉള്ള�ക്കവും 
ഡ�ോഹര
ോയി ക്ര
ീകരിച്ച്, 

പ്രിന്റ്  ടെ�യ്യുന്നതി�ോയി  തയ്യോറോക്കുന്ന പ്രവര്‍ത്ത�ടെത്ത ടെ�ോതുടെവ എന്ത്  

ഡ�രിലോണ് വിളിക്കുന്നത് ?

➢ ഡസ്‍ക‍്ലേ�ോപ്പ്‍പബ്ലിഷിങ്

➢ കമ്പ്യൂട്ടര്‍ പ്രിന്റിങ്

➢ ഡലസര്‍ പ്രിന്റിങ് ടെ�ക ്ഡ�ോളജി

➢ 
ോര്‍ക്ക് അ�് സോഡ6തിക വിദ്യ

2. ലിബര്‍ഓഫീസ് റൈററ്റര്‍ ഡസോഫ്റ്റ് ടെവയറില്‍ തയ്യോറോക്കുന്ന ഒരു ഡ
ോക്യുടെ
ന്റില്‍ 

ഉള്ള�ക്കപ്പട്ടിക ഉള്‍ടെപ്പടുത്തുന്നതി�ോയി �ില �ദങ്ങടെള ശീര്‍ഷകങ്ങളോയി 

�ിര്‍വ�ിക്കണം. ഇതിനു ഉ�ഡയോഗിക്കോവുന്ന സഡ6തം ഏതോണ് ?

➢ Style

➢ Clone

➢  Filter

➢ Mail Merge

3. ഒരു ഡ
ോക്യുടെ
ന്റിടെല �ില ഭോഗങ്ങള്‍ക്ക് �ല്കിയിട്ടുള്ള ഡഫോര്‍
ോറ്റുകള്‍ 

അഡത��ി 
റ്റു സ
ോ� ഭോഗങ്ങളില്‍ �കര്‍ത്തോന്‍ (ലിബര്‍ഓഫീസ് 

റൈററ്ററില്‍) ഉ�ഡയോഗിക്കോവുന്ന സഡ6തം തോടെR �റയുന്നവയില്‍ ഏതോണ് ?

➢ ടെ
യില്‍ ടെ
ര്‍ജ്

➢ 
സ ്ക ്ഡ�ോപ്പ് �ബ്ലിഷിങ്

➢ ഇന്‍
ക്സ്  ഡഫോര്‍
ോറ്റിങ്

➢ ലേ�ോണ്‍‍ലേ�ോര്‍മോറ്റിങ്

http://www.shenischool.in/
https://t.me/Shenibloggroup


4. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ ഒഡന്നോ രഡVോ ഡ�ജുള്ള 

ഡ
ോക്യുടെ
ന്റില്‍ ഒരു ശീര്‍ഷകത്തി�്  �ല്‍കിയ ഡഫോര്‍
ോറ്റുകള്‍ 
റ്റ് ശീര്‍

ഷകങ്ങള്‍ക്ക് കൂ�ി �ല്‍കോന്‍ ചുവടെ� ടെകോടുത്തിരിക്കുന്നവയില്‍ ഏതോണ് 

ഉ�ഡയോഗിഡക്കVത്?

➢ Bullets and Numbering

➢ Indexes and Tables

➢ Print

➢ Clone Formatting

5. തോടെR ടെകോടുത്തിട്ടുള്ളവയില്‍  ടെ
യില്‍ടെ
ര്‍ജ് സഡ6തം ഉ�ഡയോഗിച്ചു ടെ�യ്യോന്‍

കRിയുന്ന പ്രവര്‍ത്ത�ം ഏത്?

➢ ഡോറ്റോലേ�സിലുള്ള‍വിവരങ്ങള്‍‍ടെ�ക്‍സ്റ്റ്‍ലേഡോക്യുടെമന്റിലേ�ക്ക്‍ലേ'ര്‍ക്കോന്‍‍

➢ ടെ�ക് സ്റ്റ് ഡ
ോക്യുടെ
ന്റിടെല വിവരങ്ങള്‍ 
ോറ്റോഡബസിഡലക്ക് ഡ�ര്‍ക്കോന്‍

➢ 
ോറ്റോഡബസുകളിടെല വിവരങ്ങള്‍ �രസ്പരം 
ോറ്റോന്‍

➢ റിഡപ്പോര്‍ട്ടിഡലക്ക് ആവശ്യ
ോയ വിവരങ്ങള്‍ 
ോറ്റോഡബസില്‍ തിരയോന്‍

6. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ ഒരു  ഡ
ോക്യുടെ
ന്റില്‍, �ിറത്തിലും 

വലുപ്പത്തിലും രൂ�ത്തിലുടെ
ല്ലോം ഐകരൂ�്യമുള്ള തലടെക്കട്ടുകളും 

ഉള്ള�ക്കവുമുള്ള ഡ�ജുകള്‍ തയ്യോറോക്കുന്നതി�് തോടെR �റയുന്ന ഏടെതല്ലോം 

സഡ6തങ്ങള്‍ ഉ�ഡയോഗിക്കോം ?

➢ Clone Formatting, Style

➢ Index building, Desktop Publishing

➢ Clone Formatting, Mail Merge

➢ Mail Merge, Desktop Publishing

7. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ സ്കൂളിടെ�ക്കുറിച്ച് 50 ഡ�ജുള്ള ഒരു റിഡപ്പോര്‍ട്ട് 

തയ്യോറോക്കി. ഇതിടെല ശീര്‍ഷകങ്ങടെള ഒഡര രീതിയില്‍ ഡഫോര്‍
ോറ്റ് 
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ടെ�യ്യോനും �ല്‍കിയ ഡഫോര്‍
ോറ്റുകള്‍ ഡവഗത്തില്‍ ടെ
ച്ചടെപ്പടുത്തുവോനും 

സഹോയിക്കുന്ന സഡ6തം ഏതോണ്?

➢ Clone Formatting 

➢ Paragraph 

➢ Formatting Style 

➢ Page Formatting

8. ഒരു ഡ�ജിടെന്റ ഉള്ള�ക്കത്തിടെല ഒരു‍പദം‍ശീര്‍ഷകമോയി‍നിര്‍വ'ിക്കോന്‍‍

ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ ലഭ്യ
ോയിട്ടുള്ള‍ഏത് റൈസ്റ്റല്‍ ഉ�ഡയോഗിക്കോം ?

➢ Header 1

➢ Caption 1

➢ Index 1

➢ Heading 1

9. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ �ില ഡ�ജുകളില്‍ 

ഉ�ഡയോഗിച്ചിരിക്കുന്ന  റൈസ്റ്റലുകളില്‍ 
ോറ്റം വരുത്തണം.

ഡ�ജിടെല ഉള്ള�ക്കത്തില്‍ 
ലയോളം 

ഡഫോണ്ടുകളോണ് 

ഉ�ഡയോഗിച്ചിരിക്കുന്നടെത6ില്‍   

�ിത്രത്തില്‍ കോണിച്ചിരിക്കുന്ന ഏതു 

ഭോഗത്തോണ് 
ോറ്റം വരുഡത്തVത് ?

➢ Western Text Font

➢ CTL Font

➢ Font Effects

➢ Lorem Ipsum
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10. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ ഒരു ഡ
ോക്യുടെ
ന്റിടെല                       

ശീര്‍ഷകങ്ങളുഡ�യും ഉ�ശീര്‍ഷകങ്ങളുഡ�യും ഏത് പ്രഡത്യകത തിരിച്ചറിഞ്ഞോണ് 

കമ്പ്യൂട്ടര്‍ അവടെയ ഉള്ള�ക്ക�ട്ടിക (Index Table)യില്‍ ഉള്‍ ടെപ്പടുത്തുന്നത് ?

➢ ശീര്‍ഷകങ്ങളുഡ�യും ഉ�ശീര്‍ഷകങ്ങളുഡ�യും �ിറം (color)

➢ ശീര്‍ഷകങ്ങളുഡ�യും ഉ�ശീര്‍ഷകങ്ങളുഡ�യും വലുപ്പം (size)

➢ ശീര്‍ഷകങ്ങളുലേ�യും‍ഉപശീര്‍ഷകങ്ങളുലേ�യും‍സ്റ്റൈസ്റ്റല്‍‍‍(style)style)

➢ ശീര്‍ഷകങ്ങളുഡ�യും ഉ�ശീര്‍ഷകങ്ങളുഡ�യും ഇന്‍
ന്റ് (indent)

11. ലിബര്‍ഓഫീസ്  റൈററ്ററില്‍  തയോറോക്കിയ  ഒരു ഡ
ോക്യുടെ
ന്റിടെല 

ഉള്ള�ക്കപ്പട്ടികയില്‍�ിന്ന് അവയു
ോയി ബന്ധടെപ്പട്ട  ഡ�ജുകളിഡലക്ക് ഡ�ോകോന്‍

എന്തോണ് ടെ�ഡയ്യVത് ?

➢ Ctrl കീ‍അമര്‍ത്തിപ്പി�ിച്ചുടെകോണ്ട്‍ശീര്‍ഷകം‍�ിക്ക്‍ടെ'യ്യുക.

➢ Alt കീ അ
ര്‍ത്തിപ്പി�ിച്ചുടെകോV് ശീര്‍ഷകം ക്ലിക്ക് ടെ�യ്യുക.

➢ Shift കീ അ
ര്‍ത്തിപ്പി�ിച്ചുടെകോV് ശീര്‍ഷകം ക്ലിക്ക് ടെ�യ്യുക.

➢ Tab കീ അ
ര്‍ത്തിപ്പി�ിച്ചുടെകോV് ശീര്‍ഷകം ക്ലിക്ക് ടെ�യ്യുക.

12. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ ഒരു ഡ
ോക്യടെ
ന്റില്‍ ഉള്ള�ക്ക�ട്ടിക 

ഉള്‍ടെപ്പടുത്തിയഡശഷം  അത് �ി
ിഎഫ് ആയി എക്സ്ഡ�ോര്‍ട്ട് ടെ�യ്തു. ഈ  

ഫയല്‍ തുറന്ന് ഉള്ള�ക്കപ്പട്ടികയില്‍ �ിന്ന് ഒരു പ്രഡത്യക ഉള്ള�ക്കത്തിഡലക്ക്  

ഡ�ോകോന്‍ എന്തോണ് ടെ�ഡയ്യVത്?

➢ ഉള്ള�ക്കപട്ടികയിടെ�‍അതത്‍�ിങ്കില്‍‍�ിക്‍ടെ'യ്തോല്‍‍മതി

➢ ഉള്ള�ക്ക�ട്ടികയിടെല ലി6ില്‍ Alt കീ അ
ര്‍ത്തിപ്പി�ിച്ച് ക്ലിക് ടെ�യ്തോല്‍ 
തി

➢ ഉള്ള�ക്ക�ട്ടികയിടെല ലി6ില്‍ Ctrl കീ അ
ര്‍ത്തിപ്പി�ിച്ച് ക്ലിക് ടെ�യ്തോല്‍ 
തി
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➢ �ി
ിഎഫ്  ആയി എക്സ്ഡ�ോര്‍ട്ട് ടെ�യ്തോല്‍  ഉള്ള�ക്ക �ട്ടിക                      

പ്രവര്‍ത്തിക്കോതോകുന്നു.

13. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയ്യോറോക്കിയിട്ടുള്ള ഒരു ക്ഷണക്കത്തിഡലക്ക്, 

സ്വീകര്‍ത്തോക്കളുടെ� ഡ�രും വിലോസവു
�ങ്ങിയ ഒരു �ട്ടികയിടെല വിവരങ്ങള്‍ 

ഒടെന്നോന്നോയി ഉള്‍ടെപ്പടുത്തോന്‍ പ്രഡയോജ�ടെപ്പടുന്ന സഡ6തം ഏതോണ്?

➢ Formatting

➢ Style

➢ Mail Merge

➢ Index

14. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ, വലിയ ഡ
ോക്യുടെ
ന്റുകളില്‍ 

റൈസ്റ്റലുകള്‍ ഉ�ഡയോഗിക്കുന്നതുടെകോV് ഉVോഡയക്കോവുന്ന �ില 

പ്രഡയോജ�ങ്ങള്‍ തോടെR ഡ�ര്‍ക്കുന്നു. ഇവയില്‍ ടെതറ്റോയത് എത് ?

➢ റൈസ്റ്റലുകള്‍ ഒരിക്കല്‍ ഉ�ഡയോഗിച്ചു കRിഞ്ഞോല്‍ �ിന്നീടുള്ള 
ോറ്റങ്ങള്‍ 

അതതു റൈസ്റ്റലില്‍വരുത്തിയോല്‍ 
തി

➢ റൈസ്റ്റലുകള്‍ ഉ�ഡയോഗിച്ചിട്ടുള്ള എല്ലോയി�ത്തും അതത് 
ോറ്റങ്ങള്‍ 

പ്രതിഫലിക്കും.

➢ വലിയ  പുസ്തകങ്ങഡളോ ഡ
ോക്യുടെ
ന്റുകഡളോ തയ്യോറോക്കുഡമ്പോള്‍ ഇത് ഡജോലി 

എളുപ്പ
ോക്കുന്നു.

➢ ഒലേര‍ലേഡോക്യുടെമന്റില്‍‍തടെ=‍വിവിധ‍ഭോഷകള്‍‍സ്റ്റൈകകോര്യം‍ടെ'യ്യു=ത്‍എളുപ്പമോക്കുന്നു.

15. ലിബര്‍ഓഫീസ് റൈററ്ററിലുള്ള ഒരു ടൂള്‍ ആണ് ചുവടെ�

ടെകോടുത്തിരിക്കുന്നത്. ഇത് എന്ത് ആവശ്യത്തിനുള്ളതോണ് ?

➢ Insert Chart 

➢ Apply Style Box

➢ Add Decimal Place
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➢ Clone Formatting

16. ഒരു സോംസ്കോരിഡകോത്സവത്തിഡലക്ക് �6ോളികടെള ക്ഷണിക്കുന്നതിനുള്ള 

ക്ഷണക്കത്തിടെന്റ 
ോതൃക Invitation.odt എന്ന ഫയലോയും, ക്ഷണിതോക്കളുടെ� 

ഡ�രും വിലോസവു
�ങ്ങിയ �ട്ടിക  Address.ods എന്ന ഫയലോയും 

തയ്യോറോക്കിയിട്ടുV്. �ടെ6ടുഡക്കVവരുടെ� ഡ�രും വിലോസവും 
ോതൃകയിഡലക്ക് 

ഒടെന്നോന്നോയി ഉള്‍ടെപ്പടുത്തി ടെവഡzടെറ ക്ഷണക്കത്തുകള്‍ തയ്യോറോക്കണം. 

ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ ഇതി�് പ്രഡയോജ�ടെപ്പടുന്ന സഡ6തം ഏതോണ്?

➢ Clone Formatting

➢ Style

➢ Mail Merge

➢ Indexes and Tables

17. ലിബര്‍ഓഫീസ്  റൈററ്ററിടെല വിവിധ  റൈസ്റ്റലുകള്‍  തിരടെഞ്ഞടുക്കുന്നതിനുള്ള 

Styles  ജോലത്തിടെന്റ ഒരു ഭോഗ
ോണ്  �ിത്രത്തില്‍  കോണുന്നത് .  ചുവന്ന 

വൃത്തത്തില്‍ അ�യോളടെപ്പടുത്തിയ റൈസ്റ്റല്‍ ഏത് ?

➢ Character Styles

➢ Frame Styles

➢ Page Styles

➢ Paragraph Styles

18. ഗീത, ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ ഡപ്രോജക്ട് റിഡപ്പോര്‍ട്ടിടെന്റ      

ശീര്‍ഷകങ്ങള്‍ക്ക് �ല്‍കോ�ോയി ഒരു പുതിയ റൈസ്റ്റല്‍                              
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�ിര്‍മ്മിക്കോനുഡ�ശിക്കുന്നു. തോടെRക്കോണുന്നതുഡ�ോടെല രV് ടെസറ്റ് ഡഫോര്‍


ോറ്റുകള്‍ ഇതി�ോയി തയ്യോറോക്കിയിട്ടുV്.

സെസറ്റ്  1: അക്ഷര വലുപ്പം : 13, അക്ഷര ഫോ
ിലി :  ര��,  അക്ഷര 

�ിറം : ചുവപ്പ്

സെസറ്റ് 2:  
ോര്‍ജി�ില്‍ �ിന്നുള്ള അകലം : 18, ടെ�ക് സ്റ്റ്                

അറൈലന്‍ടെ
ന്റ് : ഇ�ത്

ഒരു തലടെക്കട്ടിടെ� സംബന്ധിച്ച്,  ഈ  ടെസറ്റുകളില്‍ ഏതു�ഡയോഗിച്ചോണ്  

ഡഫോര്‍
ോറ്റ് ടെ�യ്യുവോന്‍ സോധിക്കുക?

➢ രണ്ടു‍ടെസറ്റുകളും‍ഉപലേയോഗിക്കോം‍

➢ ആദ്യ ടെസറ്റ് 
ോത്രഡ
 തലടെക്കട്ടി�് ഡയോജിക്കുകയുള്ളു

➢ രVോ
ടെത്ത ടെസറ്റ് 
ോത്രഡ
 തലടെക്കട്ടി�് ഡയോജിക്കുകയുള്ളു

➢ രണ്ടു ടെസറ്റുകളും ഡയോജിച്ചവയല്ല

19. ലിബര്‍ഓഫീസ് റൈററ്ററില്‍ തയോറോക്കിയ ഒരു ഡ
ോക്യുടെ
ന്റിടെല 

ഉള്ള�ക്കപ്പട്ടികടെയ സംബന്ധിക്കുന്ന �ില പ്രസ്തോവ�കള്‍ ചുവടെ� ഡ�ര്‍ക്കുന്നു. 

പ്രസ്താവന 1: ഡ
ോക്യുടെ
ന്റിടെന്റ വിവിധ ശീര്‍ഷകങ്ങളുള്‍ടെപ്പടുന്ന 

ഡ�ജുകളിഡലക്ക് എളുപ്പത്തില്‍ എത്തോന്‍ സോധിക്കുന്നു.

പ്രസ്താവന 2:ഡ
ോക്യുടെ
ന്റിടെല ഉള്ള�ക്കടെത്ത കുറിച്ചുള്ള ടെ�ോതുവോയ ധോരണ 

എളുപ്പത്തില്‍ ലഭിക്കുന്നു.

ഇവയില്‍ ശരിയോയത് ഏത്?

➢ രണ്ടും‍ശരിയോണ്.

➢ രണ്ടും ടെതറ്റോണ്.
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➢ ഒന്നോ
ത്ത പ്രസ്തോവ� ശരിയോണ്. രVോ
ടെത്ത പ്രസ്തോവ�  ടെതറ്റോണ്.

➢ ഒന്നോ
ടെത്ത പ്രസ്തോവ� ടെതറ്റോണ്.രVോ
ടെത്ത പ്രസ്തോവ� ശരിയോണ്.

20. ഡകരളടെത്തക്കുറിച്ചുള്ള ഒരു ഡ
ോക്യുടെ
ന്റി�് തയ്യോറോക്കിയ ഉള്ള�ക്കപ്പട്ടികയുടെ� 

ഒരു ഭോഗ
ോണ് �ിത്രത്തില്‍ കോണുന്നത്. ഇതില്‍ തലടെക്കട്ടി�് (Index)  

സോധോരണ ഗതിയില്‍ എന്തു റൈസ്റ്റലോയിരിക്കും ഉVോയിരിക്കുക ?

➢ Contents Heading

➢ Figure Index Heading

➢ Heading 1

➢ Header 1
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STANDARD X  INFORMATION TECHNOLOGY
UNIT 3 :   വെ�ബ്ഡിസൈ�നിങ് മിഴിവ�ോവെ�

THOERY QUESTIONS MALA MEDIUM 

COMPILED BY PRAPHUL P , EACHOME KANNUR 9496990081

1) തോവെഴ വെ-ോടുത്തിരിക്കുന്ന�യില്‍ വെ�ബ്വ5ജിവെ7 സൈ8ല്‍  ആയി നിര്‍

വ്വചിക്കോവുന്ന� ഏവെതോവെക്കയോണ് ?  

a) ശബ്ദം, ചലച്ചിത്രം തു �ങ്ങിയ�  b)നിറം, അക്ഷരങ്ങളുടെ� വലുപ്പം 

തു�ങ്ങിയവ

c)5ട്ടി--ള്‍, ഗ്രോഫു-ള്‍ തു�ങ്ങിയ�  d) �ോക്കു-ള്‍, ചിത്രങ്ങള്‍ 

തു�ങ്ങിയ�

2) വെ�ബ് വ5ജു-ളില്‍ ഉ5വയോഗിക്കുന്ന സൈ8ല്‍ ഷീററു-ള്‍ 

  മവെ[ോരു വ5രിലും അറിയവെ_ടുന്നു. ഏത് വ5രില്‍? 

a.ടെ�ംപ്ലേ�റ്റുകള്‍    b.എഡി[റു-ള്‍   c.-വcോ�റു-ള്‍ d.മോര്‍ക്ക് അപ്പു-ള്‍

3)  വെ�ബ്വ5ജു-ള്‍ തയോറോക്കുവcോള്‍ html �ോഗു-ളുവ�യും 

ആട്രിബ്യൂട്ടു-ളുവെ�യും ആ�ര്‍ത്തിച്ചുള്ള ഉ5വയോഗം ഒഴി�ോക്കോന്‍ 

ഉ5വയോഗിക്കുന്ന �വtതം ഏത് ?

a. കാപ്ലേ�ഡിങ് സ്റ്റൈ�ല്‍ ഷീറ്റുകള്‍    b.styles and formating tools

c. html എഡി[റു-ള്‍                  d. വെ�ക്സ്[് എഡി[റു-ള്‍

4)  വെ�ബ് വ5ജു-ളില്‍ ഉ5വയോഗിക്കുന്ന -ോവ�ഡിങ് സൈ8ല്‍ ഷീറ്റു-ളുവെ�

 ധര്‍മ്മം എന്ത് ?

a. വെ�ബ്വ5ജു-ള്‍ ഏത് ബ്രൗ�റില്‍ തുറക്കണവെമന്ന് നിശ്ചയിക്കു-. 

b. വെ�ബ്വ5ജു-ളുവെ� 5-ര്‍_�-ോശം നിശ്ചയിക്കു-. 

c. വെ�ബ്വ5ജു-ളില്‍  �ീഡിവയോ ഉള്‍വെ_ടുത്തു-.

d. mark-up ഭാഷയില്‍ തയ്യാറാക്കുന്ന ടെവബ് പ്ലേ/ജ് എങ്ങടെ2 

ദൃശ്യമാക്കണടെമന്ന് പ്രതി/ാദിക്കുക

5) Hakon Wium Lie,  Bert Bos എന്നി�ര്‍ വെ�ബ്വ5ജ് നിര്‍മോണം 

ഏളു_മോക്കുന്നതില്‍ �ലിയ 5t് �ഹിച്ച�രോണ്. അ�രുവെ� �ംഭോ�ന 

എന്തോണ്?

a. markup language

b.      html tags

c.         cascading styles
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STANDARD X  INFORMATION TECHNOLOGY
UNIT 3 :   വെ�ബ്ഡിസൈ�നിങ് മിഴിവ�ോവെ�

d.          python codes

6) വെ�ബ് വ5ജു-ളില്‍ ഉ5വയോഗിക്കുന്ന സൈ8ല്‍ ഷീ[് ഫയലിവെ7  

എക്സ്[ന്‍ഷന്‍ തോവെഴ വെ-ോടുത്തിട്ടുള്ള�യില്‍ ഏതോയിരിക്കും ?

a.  .html  b. .css    c.  ss       d.   .ssf

7) വെ�ബ്വ5ജ് നിര്‍മോണത്തില്‍ { } എന്ന ചിഹ്നം ഉ5വയോഗിക്കുന്ന �ന്ദര്‍ഭം 

തോവെഴ വെ-ോടുത്തിരിക്കുന്ന�യില്‍ ഏതോണ് ?

a)�ോക്കു-ള്‍, ചിത്രങ്ങള്‍ തു�ങ്ങിയ� ഉള്‍വെ_ടുത്തുവcോള്‍  

 b.  ശബ്ദം, ചലച്ചിത്രം തു �ങ്ങിയ�  ഉള്‍വെ_ടുത്തുവcോള്‍    

c. കാസ് പ്ലേകഡിങ് സ്റ്റൈ�ല്‍ ഉള്‍ടെപ്പടുത്തുപ്ലേIാള്‍

d.   5ട്ടി--ള്‍, ഗ്രോഫു-ള്‍ തു�ങ്ങിയ� ഉള്‍വെ_ടുത്തുവcോള്‍

8)  വെ�ബ് വ5ജ് നിര്‍മ്മിക്കുവcോള്‍ �ോഗിവെ7 വ5ര് തവെന്ന -ോവ�ഡിങ് 

സൈ8ല്‍ തയോറോക്കോന്‍ ഉ5വയോഗിക്കുന്നത് എന്ത് വ5രില്‍ 

അറിയവെ_ടുന്നു? 

a. element selector     b. class selector
c. internal selector     d.             external selector

9) അനു ഒരു വെ�ബ് വ5ജ് തയ്യോറോക്കു-യോണ് . അതില്‍ ഒരു �ോ-്യം അടുത്ത

�രിയില്‍ പ്രദര്‍ശി_ിക്കോന്‍ ഉ5വയോഗിവക്കണ്ട �ോഗ് ഏതോണ് ?

a. <br>  b. <cr>   c. <tr>    d. <pr>

10)  വെ�ബ്വ5ജ് നിര്‍മോണത്തില്‍ ഒന്നിലധി-ം വെ�ബ്വ5ജു-ള്‍ക്ക്  ഒവര 

വലഔട്ട് നല്‍-ോന്‍ �ഹോയിക്കുന്ന �ം�ിധോനം  തോവെഴ 

വെ-ോടുത്തിരിക്കുന്ന�യില്‍ ഏതോണ് ?

a. wysiwyg �വtതം  b. വെ�ബ് ബ്രൗ�റു-ള്‍  c. സൈ8ല്‍�് ആന്‍
ഡ് വഫോര്‍മോ[ിങ്ങ്  �വtതം  d. കാപ്ലേ�ഡിങ് സ്റ്റൈ�ല്‍ ഷീറ്റുകള്‍

11)  വെ�ബ്വ5ജു-ള്‍ തയോറോക്കുവcോള്‍ തോവെഴതന്നിരിക്കുന്ന�യില്‍ ഏത് 

�ോഗു-ള്‍ക്കി�യിലോണ് -ോ�് വ-ഡിങ് സൈ8ലു-ള്‍ ഉള്‍വെ_� ുവത്തണ്ടത് ? 

a. <font>...</font> b. <style>...</style>

c. <br>...</br>    d. <a>...</a>

12) വെ�ബ്വ5ജു-ളില്‍ -ോവ�ഡിങ് സൈ8ലു-ള്‍ ഉ5വയോഗിക്കുവcോള്‍ 

അക്ഷരരൂ5ങ്ങവെള നിര്‍വ്വചിക്കോന്‍ ഉ5വയോഗിക്കുന്ന ആട്രിബ്യൂട്ട് തോവെഴ 
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തന്നിരിക്കുന്ന�യില്‍ ഏതോണ് ? 

a. font-family   b. font      c) font-face     d. font-property

13) വെ�ബ്വ5ജു-ള്‍ തയോറോക്കുവcോള്‍ html �ോഗു-ളുവെ� കൂവെ�ത്തവെന്ന 

 അ�യ്ക്കുവ�ണ്ട ��ിവശഷത-ളും -ോവ�ഡിങ് സൈ8ല്‍ രീതിയില്‍ 

 ഉള്‍വെ_ടുത്തോം. ഇതിവെന 5റയുന്ന വ5വെരന്ത് ?

a. inline css   b. external css   c. internal css

d. style css

14)

 

ഒരുവെ�ബ് വ5ജിവെ7 വ-ോഡു-ളോണ് തന്നിരിക്കുന്നത്. ഇതില്‍  

-ോവ�ഡിങ് സൈ8ലു-ള്‍ ഉള്‍വെ_ടുത്തിയിരിക്കുന്നത് തോവെഴ 

തന്നിരിക്കുന്ന�യില്‍ ഏത് രീതിയിലോണ് ?

a. inline css    b.external css  c. internal css    d. style css

15)  വെ�ബ്വ5ജു-ള്‍ തയോറോക്കുവcോള്‍ -ോവ�ഡിങ് സൈ8ല്‍ രീതിയില്‍ 

അക്ഷര�ലു_ംനിര്‍വ്വചിക്കുന്നത്  തോവെഴ വെ-ോടുത്തിരിക്കുന്നതില്‍ ഏത് 

ഉ5വയോഗിച്ചോണ്  ?

a. font-hight   b.font-width   c. font-size   d. font-property

 16) വെ�ബ് വ5ജിവെ7 വ-ോഡു-ളോണ് തന്നിരിക്കുന്നത്.  ഇതില്‍ തലവെക്കട്ടു-ള്‍

ക്ക് തയ്യോറോക്കിയിരിക്കുന്ന -ോവ�ഡിങ് സൈ8ല്‍  തോവെഴ 

തന്നിരിക്കുന്ന�യില്‍ ഏതുതരം ആണ്?
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a element selector     b. class selector
c internal selector    d external selector

17 വെ�ബ്വ5ജു-ള്‍ തയോറോക്കുവcോള്‍ -ോവ�ഡിങ് സൈ8ല്‍ രീതിയില്‍  

5ോരഗ്രോഫു-ളുവെ� ��ിവശഷത-ള്‍ നിര്‍�ചിക്കോവുന്ന  ക്ലോസ്സ് വെ�ലക്ടര്‍ തോവെഴ 

വെ-ോടുത്തിരിക്കുന്ന�യില്‍ ഏത് ?

a. p{green}   b. p.green   c. p<green>     d. p-green

18. ഒരുവെ�ബ് വ5ജിവെ7 വ-ോഡു-ളോണ് തന്നിരിക്കുന്നത്. ഇതില്‍ 

5ോരഗ്രോഫു-ള്‍ക്ക് തയ്യോറോക്കിയിരിക്കുന്ന  -ോവ�ഡിങ് സൈ8ല്‍ തോവെഴ 

തന്നിരിക്കുന്ന�യില്‍ ഏതുതരം ആണ് ?

a. element selector   b. class selector
c. internal selector         d. external selector

19)  വെ�ബ്വ5ജു-ള്‍ തയോറോക്കിയവ_ോള്‍ -ോവ�ഡിങ് സൈ8ല്‍ രീതിയില്‍ 

 h2 �ോഗിന്  head  എന്ന വ5രില്‍ ഒരു ക്ലോസ്സ് വെ�ലക്ടര്‍ നിര്‍വ്വചിച്ച് 

 ��ിവശഷത-ള്‍ നല്‍-ി.   തോവെഴ വെ-ോടുത്തിരിക്കുന്ന�യില്‍ പ്രസ്തുത

 ക്ലോസ്സ് വെ�ലക്ടവെറ സൂചി_ിക്കുന്നത് ഏതോയിരിക്കും ?

http://www.shenischool.in/
https://t.me/Shenibloggroup


STANDARD X  INFORMATION TECHNOLOGY
UNIT 3 :   വെ�ബ്ഡിസൈ�നിങ് മിഴിവ�ോവെ�

a)h2.head   b)  h2<head>  c)  h2 {head}  d)  h2-head

20)  ഒരു വെ�ബ് വ5ജില്‍ ഒവര  �ോഗ് ഉ5വയോഗിച്ച് ഉള്‍വെ_ടുത്തിയിരിക്കുന്ന  

�്യത്യസ്ത ഉള്ള�ക്കങ്ങള്‍ക്ക് വെ�വവ്വവെറ ��ിവശഷത-ള്‍ 

വെ-ോടുക്കണവെമtില്‍ തോവെഴ തന്ന�യില്‍ ഏത്  ഉ5വയോഗിക്കും?

a.ക്ലാസ്സ് ടെസലക്ടര്‍  c. സൈഹ_ര്‍ ലിt് c)എലിവെമ7് വെ�ലക്ടര്‍ d)D. ഒബ്ജക്ട് വെ�ലക്ടര്‍

21) വെ�ബ്വ5ജു-ള്‍ തയോറോക്കിയവ_ോള്‍ -ോവ�ഡിങ് സൈ8ല്‍ രീതിയില്‍ 

 5ോരഗ്രോഫ് �ോഗിന്  para1  എന്ന വ5രില്‍ ഒരു ക്ലോസ്സ് വെ�ലക്ടര്‍ നിര്‍ 

വ്വചിച്ച് ��ിവശഷത-ള്‍ നല്‍-ി.  ഇതില്‍ വെ-ോടുത്തിരിക്കുന്ന 

��ിവശഷത-ള്‍  വെ�ബ്വ5ജില്‍ ദൃശ്യമോ-ണവെമtില്‍ തോവെഴ 

വെ-ോടുത്തിരിക്കുന്ന�യില്‍ ഏതോണ് ഉ5വയോഗിവക്കണ്ടത് ?

a. p.class= para1   b. p<class=para1>  

c.<p class = "para1">  d. <p para1>

22) q വെ�ബ് വ5ജില്‍ -ോവ�ഡിങ് സൈ8ലു-ള്‍ ഉ5വയോഗിക്കുവcോള്‍  h1 എന്ന

വെഹഡിങ്ങ്  �ോഗിവെ7  ക്ലോസ്സ് വെ�ലക്ടര്‍  ആ-ോവുന്നത് ചു�വെ� 

വെ-ോടുത്തിരിക്കുന്ന�യില്‍ ഏതോണ് ?

a. h1{green}   b. h1.green

c. h1<green>  c. h1 [ green]  

23) വദവു ഒരു വെ�ബ്വ5ജില്‍   h2 �ോഗിന് തവെ7 വ5രില്‍ ഒരു ക്ലോസ്സ് �ിലക്ടര്‍ 

നിര്‍വ്വചിച്ച് ��ിവശഷത-ള്‍ നല്‍-ി. തോവെഴവെ-ോടുത്തിരിക്കുന്ന�യില്‍ 

ഏതോണ് ആ ക്ലോസ്സ് �ിലക്ടര്‍ ?

a) h2.devu   b)h2<devu>   c) h2[devu] d)  h2{devu}

24) വെ�ബ്വ5ജു-ള്‍ തയോറോക്കുവcോള്‍ -ോവ�ഡിങ് സൈ8ല്‍ രീതിയില്‍
 വ5ജിന് 5ശ്ചോത്തലനിറം  നല്‍കു�ോന്‍  തോവെഴ വെ-ോടുത്തിരിക്കുന്ന�യില്‍ 
 ഏത് രീതിയോണ്  ഉ5വയോഗിവക്കണ്ടത് ?

a. body { background:#EE9494; }

b.  body < background:#EE9494; >

c body [ background:#EE9494; ]
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d body bgcolor=”#EE9494”

 25) വെ�ബ്സൈ�[് തയ്യോറോക്കോന്‍ നമ്മവെള �ഹോയിക്കുന്ന WCMS എന്നതിവെ7 

പൂര്‍ണ്ണ രൂ5ം എന്തോണ് ?

a. Web Content Management System

b. Web Control Machine System

c. Wiki Content Management system

d Wiki Control Machine System

26) ഒരു വെ�ബ് വ5ജിവെല h2 �ിഭോഗത്തില്‍വെ_ട്ട വെഹഡ്ഡിങ്ങു-ള്‍വെക്കല്ലോം 

External -ോ�് വ-ഡിങ് സൈ8ലു-ള്‍ ഉ5വയോഗിച്ച് ഒവര അക്ഷര രൂ5ം

 നല്‍-ണം.  ഇതിനോയി css ഫയലില്‍ വെ-ോടുവക്കണ്ട നിര്‍വÁശം ഏത് ?  

a h2 – font-family = " DejaVu Sans "

b h2 – font-family=  DejaVu Sans

c h2 { font-family : DejaVu Sans ; }

d h2 < font-family = DejaVu Sans >

27)  വെ�ബ്വ5ജിന്  5ശ്ചോത്തലനിറം നല്‍-ോനോയി   Inline -ോ�് വ-ഡിങ് 

സൈ8ല്‍ രീതിയില്‍ ഉ5വയോഗിവക്കണ്ട  നിര്‍വÁശം ചു�വെ� നല്‍-ിയതില്‍ 

ഏതോണ് ?  

a. <body style = " background-color:gray ; ">

b. body { background-color : gray ; }

c body << background-color : gray ; >>

d <style> body { background-color : gray ; } 

</style>

28) സൈ8ല്‍ ഷീ[്ഫയലിവെന ഒരു വെ�ബ് വ5ജിവലക്ക് ഉള്‍വെ_ടുത്തോന്‍ 

ഉ5വയോഗിക്കുന്ന  �ോഗ് ചു�വെ� വെ-ോടുത്തിട്ടുള്ള�യില്‍ നിന്ന് 

തിരവെÆടുക്കു-.വെ�ബ്വ5ജിന്  5ശ്ചോത്തലനിറം നല്‍-ോനോയി  Internal 

-ോ�് വ-ഡിങ് സൈ8ല്‍  രീതിയില്‍ ഉ5വയോഗിവക്കണ്ട  നിര്‍വÁശം ചു�വെ�

നല്‍-ിയതില്‍ ഏതോണ് ?  
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a <body style = " background : blue ; " >

b body { background : blue ; }  

c body << background : blue ; >>

d <style> body { background : blue ; } </style>

29) സൈ8ല്‍ ഷീ[്ഫയലിവെന ഒരു വെ�ബ് വ5ജിവലക്ക് ഉള്‍വെ_ടുത്തോന്‍ 

ഉ5വയോഗിക്കുന്ന �ോഗ് ചു�വെ� വെ-ോടുത്തിട്ടുള്ള�യില്‍ നിന്ന് തിരവെÆടുക്കു-.

<css>  b. <link>  c.<hyperlink>  d. <interlink>

30) -ോ�് വ-ഡിങ് സൈ8ല്‍ തയ്യോറോക്കുവcോള്‍ html നിര്‍വദശങ്ങളിവെല �ോഗിവെ7 
��ിവശഷത-ളും �ിലയും തമ്മില്‍ വ�ര്‍തിരിക്കോന്‍ ചു�വെ� വെ-ോടുത്തിരിക്കുന്ന 
ഏത് ചിഹ്നമോണ് ഉ5വയോഗിവക്കണ്ടത്?

a ഭിത്തിക ചിഹ്നം (:)   b അര്‍ദ്ധ�ിരോമം (;)

c പൂര്‍ണ�ിരോമം (.)     d. ബ്രോക്ക[് ({ })
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CLASS 10    I C T   CHAPTER 4 
               PYTHON GRAPHICS

 തിയറി ച�ോച	
ോത്തരങ്ങൾ    ഭോഗം  :  1

1.  

മുകളില്‍ കകോടുത്ത ച�ോഗ്രോം റണ്‍ ക�യ്തച�ോൾ ഒരു ച�ററ്ക!ന്റിക# കതറ്റ് കോരണം 

invalid syntax എന്ന സച)ശ!ോണ് വന്നത്. ശരിയോയ നിര്‍ച.ശം എന്തോണ് ?

A from turtle import* B for i in range(6) 

C forward(100): D left(60):

Correct Answer:  A from turtle import*

2. പൈ1ത്തണ്‍ ഗ്രോഫിക് സ് ച�ോഗ്രോമുകളുക4 ഔട്ട്പുട്ട് #ഭിക്കുന്നത്  എവിക4?

A പൈ1ത്തണ്‍ ക9ല്ലില്‍          B IDLE ജോ#കത്തില്‍

C പൈ1ത്തണ്‍ ഗ്രോഫിക് സ് ജോ#കത്തില്‍ D ബ്രൗസറില്‍

Correct Answer: C പൈ1ത്തണ്‍ ഗ്രോഫിക് സ് ജോ#കത്തില്‍

3. നീ#നിറത്തില്‍ സ!�തുരം വരച്ച് ചുവന്ന നിറം നിറക്കുവോന്‍ സജു ഒരു ച�ോഗ്രോം 

തയ്യോറോക്കി. എന്നോല്‍ അതില്‍ color("red") എന്നവരി കതറ്റോകണന്ന് 

അധ
ോ1കന്‍ അവചനോടു 1റഞ്ഞു. എന്തോണ് ശരിയോയ നിര്‍ച.ശം ?   



A color("blue") B color("red", "blue")

C color(red,blue) D color("blue","red")

Correct Answer: D color(“blue”, “red”)

4.

ഈ പൈത്തണ്‍ പ്രോഗ്രാം പ്രവര്‍ത്തിപ്പിച്ചാല്‍ ലഭിക്കുന്ന രൂപം എന്താണ് ?

A 600 അളവുള്ള കോണ്‍ B 1000 അളവുള്ള കോണ്‍

C ത്രികോണം D ചതുരം

Correct Answer: A 600 അളവുള്ള കോണ്‍

5. സമചതുരം നിര്‍മ്മിക്കാനായി രാജി തയ്യാറാക്കിയ ഈ പൈത്തണ്‍ പ്രോഗ്രാം 

പ്രവര്‍ത്തിപ്പിച്ചപ്പോള്‍ സമചതുരം ലഭിച്ചില്ല . പ്രോഗ്രാമിലെ ഏതു നിര്‍ദേശമാണ് 

രാജിക്ക് തെറ്റിയത്.?   
A  from turtle import*

B for i in range(4):

C forward(100) D right(60)  
                            



Correct Answer: D right(60)

6. തോകP കകോടുത്തിട്ടുള്ളവയില്‍ ഏതോണ്  പൈ1ത്തണ്‍ ച�ോഗ്രോ!ിങ്ങില്‍ 4ര്‍ട്ടില്‍ 
ഗ്രോഫികസ് �വര്‍ത്തനക്ഷ!!ോക്കുന്നതിന് നല്‍ചകണ്ട നിര്‍ച.ശം?

A clear() B begin_fill()

C from turtle import* D forward()

Correct Answer: C from turtle import*
 
7.  ഈ ച�ോഗ്രോ!ികന്റ ഔട്ട്പുട്ടില്‍ എത്ര വൃത്തങ്ങൾ ഉണ്ടോയിരിക്കും?

             A.  20 B. 10
1.   
2.              C. 4 D. 3
3.

   Correct  Answer: D. 3

8. പൈ1ത്തണ്‍ ച�ോഗ്രോം ഉ1ചയോഗിച്ച് 1ോചറ്റണ്‍ നിര്‍മ്മിക്കുചVോൾ 1ോചറ്റണിക# വരകൾക്ക് 
നീ# നിറം #ഭിക്കോന്‍ ഏത് നിര്‍ച.ശം നല്‍കണം?

  A color(blue) B color blue

C color("blue") D color "blue"

  Correct Answer: C color("blue")



9. അനു തയ്യോറോക്കിയ ഈ പൈ1ത്തണ്‍ ച�ോഗ്രോം �വര്‍ത്തി�ിച്ചച�ോൾ #ഭിച്ച 
ഔട്ട്പുട്ട് എന്തോയിരിക്കും?.

        A സ!�തുരം B ത്രിചകോണം

         C സ!1ഞ്ചഭുജം D സ!9ഡ്ഭുജം

 
   

Correct Answer:    C  സ!1ഞ്ചഭുജം

10.  ഒരു  സ!ഭുജ  ത്രിചകോണം  നിര്‍മ്മിക്കുന്നതിനുള്ള  പൈ1ത്തണ്‍  ച�ോഗ്രോ!ോണ്
നല്കിയിരിക്കുന്നത്. ചുവക4  തന്നിട്ടുള്ളതില്‍ നിന്ന് ഏത് നിര്‍ച.ശം ഉ1ചയോഗിച്ചോ#ോണ്
ത്രിചകോണത്തികന്റ വരകളുക4 വീതി നിര്‍ണ്ണയിക്കോന്‍ കPിയുക.?

         A pencolor() A pencolor()

          
       C            pen_thickness() D penline()

   Correct Answer: B pensize()

11. ഈ ച�ോഗ്രോ!ികന്റ ഔട്ട്പുട്ടോയി #ഭിക്കുന്ന  രൂ1ത്തിന് എത്രയൂനിറ്റ് നീളമുള്ള വശം 

ഉണ്ടോയിരിക്കും?

 A 144 യൂനിറ്റ്     B  100 യൂനിറ്റ്      C 100 യൂനിറ്റ്     D 6 യൂനിറ്റ്

 Correct Answer:     B   100 യൂനിറ്റ് നീളമുള്ള വശം ഉണ്ടോയിരിക്കും



12.

   
 മുകളില്‍ നല്‍കിയിരിക്കുന്ന ച�ോഗ്രോ!ില്‍ നോ#ോ!കത്ത വരിയില്‍ എന്തു !ോറ്റം വരുത്തിയോല്‍ 
സ!9ഡ്ഭുജം #ഭിക്കും? 

  A right(90) B right(120)

  C left(60) D left(90)

  Correct Answer: C left(60)

13.  പൈ1ത്തണ്‍  ഗ്രോഫിക്സ്  ച�ോഗ്രോ!ില്‍  ചുവന്ന  നിറത്തില്‍  രൂ1ം  വരയ്കുകയും  ,
വരച്ചതിനുചശ9ം  നീ#  നിറം  നിറയ് ക്കുകയും  ക�യ്യോന്‍  തോകP  കകോടുത്ത  
ഏത് നിര്‍ച	ശ!ോണ് സ്വീകരിചക്കണ്ടത് ?

  A. pencolor("blue","red") B. pencolor("red","blue")

 C. color("red","blue") d. color("blue","red")

  Correct Answer: c. color(“red”,”blue”)

14.  ഒരു പൈ1ത്തണ്‍ ച�ോഗ്രോ!ില്‍ ആവര്‍ത്തന നിര്‍ച.ശത്തിനകത്ത് വീണ്ടും ആവര്‍
ത്തിച്ചു വചരണ്ട നിര്‍ച.ശങ്ങൾ ഏതു ച1രി#ോണ് അറിയക�ടുന്നത് ?

  A ലൂ�് B      പൈവല്‍ ലൂ�്    C ചഫോര്‍ ലൂ�്      D കന�ഡ് ലൂ�്

   Correct Answer:  D കന�ഡ് ലൂ�്



   

15.  പൈ1ത്തണ്‍ ഗ്രോഫിക്സ് ച�ോഗ്രോമുകളില്‍, രൂ1ങ്ങളില്‍ നിറം നിറക്കുന്നതിനുചവണ്ടി

ഉ1ചയോഗിക്കുന്ന  begin_fill()  എന്ന നിര്‍ച.ശചത്തോ4് ച�ര്‍ന്നു നല്‍ചകണ്ട നിര്‍ച.ശം

എന്ത് ?

  A pencolor() B end_fill() C stop_fill() D start_fill()

     Correct Answer:  B end_fill()

16. ഈ ച�ോഗ്രോ!ില്‍  for k in range(4): എന്ന നിര്‍ച	ശം എന്തിനുള്ളതോണ് ?
                                                                              

    A നോ#് �തുരങ്ങൾ വരക്കോന്‍
    B നോ#് യൂണിറ്റ് നീളമുള്ള വര വരക്കോന്‍
    C നോ#് തവണ ആവര്‍ത്തിക്കോന്‍
     D നോ#് വൃത്തങ്ങൾ വരക്കോന്‍

   Correct Answer:  C നോ#് തവണ ആവര്‍ത്തിക്കോന്‍

17. തന്നിരിക്കുന്ന ച�ോഗ്രോം �വര്‍ത്തി�ിച്ചോല്‍ #ഭിക്കുന്ന രൂ1ത്തില്‍ എത്ര വൃത്ത 
ങ്ങൾ ഉണ്ടോയിരിക്കും ?

   A 50 B 6 C 60 D 10

  Correct Answer:  .B 6

18. പൈ1ത്തണ്‍ ഗ്രോഫിക് ജോ#കത്തില്‍  കതളിയുന്ന വരകൾക്ക് നീ#നിറം നല്‍
കോനുള്ള നിര്‍ച.ശം ചുവക4 നല്‍കിയവയില്‍ ഏത്?

A clr("blue") B linecolor("blue")



C pencolour(blue) D pencolor("blue")

  Correct Answer: D pencolor("blue")

19. ചുവക4 കകോടുത്തിട്ടുള്ളവയില്‍ ഏതോണ്  ഒരു കV്യൂട്ടര്‍ ഭോ9 ?

  A ജിചയോജിബ്ര B സണ്‍ചiോക്ക് 

 C ഇങ്ക്സ് ചക1് D പൈ1ത്തണ്‍

 Correct Answer : D പൈ1ത്തണ്‍

20. പൈ1ത്തണ്‍ ഗ്രോഫിക്സ് ജോ#കത്തിക# വരകളും എഴുത്തുകളും പൂര്‍ണ്ണ!ോയി 
ഇല്ലോതോക്കുവോന്‍ ഉ1ചയോഗിക്കുന്ന നിര്‍ച.ശം എന്ത് ?

 A clearscreen () B clear()

  C clrscr() D clearall ()

   

  Correct Answer: B clear()



STANDARD X – ICT – UNIT 5: നെ�റ്റ് വര്‍ക്കിങ്  - ച�ോച��ോത്തരങ്ങള്‍

1.  ലാബിലെല ഒരു കമ്പ്യൂട്ടറില്‍ സേ�വ് ലെ�യ്തിട്ടുള്ള ഫയലിലെ�  അസേ� ലാബിലെല മലെ�ാരു 
കമ്പ്യൂട്ടറുമായി പങ്കുലെവക്കുവാന്‍ �ാലെ% ലെകാടുത്തവയില്‍ ഏ�് �ൗകര്യമാണ് 
പ്രസേയാജ�ലെ/ടുത്തുക?  

➢ നെ�റ്റ് വര്‍ക്കിങ് 

➢ ഡാ�ാസേബ�് 

➢ പ്രിന്റര്‍

➢ DBMS

2. ചുവലെ; �ന്നിരിക്കുന്നവയില്‍ ലെ�� ് വര്‍ക്ക് ഹബ്ബി�് പകരമായി ഉപസേയാഗിക്കാവുന്ന 
ഉപകരണം ഏ�് ?

➢ സേകബിള്‍

➢  കണക ്;ര്‍

➢  സ്വിച്ച്

➢ പ്രിന്റര്‍

3. കമ്പ്യൂട്ടറുകലെF ലെ��് വര്‍ക്ക്  ലെ�യ്യാന്‍ ഉപസേയാഗിക്കുന്ന  UTP സേകബിFില്‍ എത്ര 
സേജാഡി വയറുകളുണ്ട്?

➢ 4

➢ 12

➢ 8

➢ 10

4.  കമ്പ്യൂട്ടറില്‍ വിവരങ്ങള്‍ ലെപ്രാ��്  ലെ�യ്യുന്നതും  സൂക്ഷിക്കുന്നതും  ചുവലെ; 
ലെകാടുത്തിരിക്കുന്ന ഏ�് രൂപത്തിലാണ് ?

➢ ഡിജിറ്റല്‍

➢ അ�സേലാഗ്

➢ ഇന്‍ഫ്രാലെറഡ് �രംഗം

➢ RF �രംഗം
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5. ലെ;ലിസേഫാണ്‍ ശൃംഖലലെയ സേമാഡവുമായി  ബന്ധി/ിക്കുന്ന�ി�ായി  സേകബിFില്‍  
ഉപസേയാഗിക്കുന്ന കണക ്;റിലെന്റ സേപലെരന്താണ് ?

➢ �്വിച്ച്

➢ RJ 45 

➢ RJ 11

➢ ഹബ്

6. ഒരു ലെ��് വര്‍ക്കിലുള്ള കമ്പ്യൂട്ടറുകള്‍ �മ്മിലുള്ള വിവര കൈകമാ�ം 
�ിയന്ത്രിക്കുന്ന�ിനുള്ള ഉപകരണം ചുവലെ; �ല്‍കിയ�ില്‍ �ിന്നും കലെണ്ടത്തുക.

➢ പ്രിന്റര്‍

➢ സ്കാ�ര്‍

➢  ഹബ് / സ്വിച്ച്

➢ ലെവബ് കാമറ

7. ലെ��് വര്‍ക്കിലുള്‍ലെ/ട്ടിരിക്കുന്ന കമ്പ്യൂട്ടറുകള്‍ക്ക്  ഐ .  പി.  അഡ്രസ്സ്  �ല്‍കുന്ന�്
�ാലെ% ലെകാടുത്തിരിക്കുന്ന ഏ�് സേപ്രാസേട്ടാസേകാള്‍ അനു�രിച്ചാണ് ?

➢ TCP/IP

➢ POP

➢ SMB

➢ SSH

8. ഡിജി�ല്‍ �ിഗ്നലുകലെF അ�സേലാഗായും �ിരിച്ചും മാറ്റുവാന്‍ ക%ിവുള്ള ഉപകരണം 
ചുവലെ; ലെകാടുത്തവയില്‍ �ിന്ന് കലെണ്ടത്തുക.

➢ ച*ോഡം

➢ RJ 45 

➢ RJ 11

➢ ഹബ്

9. ലെ;ലിസേഫാണ്‍ ശൃംഖലയിലൂലെ; ഇന്റര്‍ലെ��് �ൗകര്യം ലഭ്യമാകുന്ന�ി�്

അ�്യാവശ്യമായ ഉപകരണം ചുവലെ; �ല്‍കിയവയില്‍ �ിന്നും കലെണ്ടത്തുക.
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➢ പ്രിന്റര്‍

➢ ച*ോഡം 

➢ സ്കാ�ര്‍

➢ ലെവബ് ക്യാമറ

10. ലെ��് വര്‍ക്കിലുള്‍ലെ/ട്ടിരിക്കുന്ന ഉപകരണങ്ങളുലെ; �ാമകരണത്തിലും വിവരങ്ങള്‍ 
വി�ിമയം ലെ�യ്യുന്ന�ിനും മറ്റും പാലിസേക്കണ്ട ലെപാതു �ിയമങ്ങള്‍ 
ഏതുസേപരിലറിയലെ/ടുന്നു?

➢ ലെ��് മാ�്ക്

➢ ഐ. പി. അ ഡ്രസ്സ്

➢ ലെmയറിംഗ് 

➢ നെ�റ്റ് വര്‍ക്ക് ച,ോച-ോചക്കോളുകള്‍

11. ഒരു ലെകട്ടി;ത്തിനുള്ളിലെലസേയാ ഒരു മുറിക്കുള്ളിലെലസേയാ കമ്പ്യൂട്ടറുകലെF പരസ്പരം 
ബന്ധി/ിക്കുന്ന �ംവിധാ�ം ചുവലെ; ലെകാടുത്തിട്ടുള്ളവയില്‍ ഏ�ാണ് ? 

➢ WAN

➢ LAN

➢ PAN

➢ MAN

12 .�ന്നിരിക്കുന്നവയില്‍ IPv4 സേപ്രാസേട്ടാസേക്കാള്‍ പ്രകാരമുള്ള ഐ. പി. അഡ്രസ്സാകുവാന്‍ 
�ാധ്യ�യില്ലാത്ത�് ഏ�് ?

➢ 192.168.200.10

➢ 192.192.192.192

➢ 192.168.256.10

➢ 192.168.222.10

13. വയര്‍ലെലസ്സ്  ലെ�റ്റുവര്‍ക്കുകFില്‍ കമ്പ്യൂട്ടറുകള്‍ പരസ്പരം  ബന്ധി/ിക്കുന്ന�്  ചുവലെ; 
ലെകാടുത്തിട്ടുള്ള ഏ�് ഉപകരണം / �സേr�ം ആണ് ഉപസേയാഗിക്കുന്ന�് ?

➢ UTP സേകബിള്‍
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➢ ആര്‍.എഫ് തരംഗങ്ങള്‍

➢ ഹബ്

➢ �്വിച്ച് 

14. �ാലെ% ലെകാടുത്തവയില്‍ കമ്പ്യൂട്ടറുകലെF  ലെ��് വര്‍ക്ക്  ലെ�യ്യുന്ന�ി�്
ആവശ്യമില്ലാത്ത ഉപകരണം ഏ�ാണ് ?

➢ പരസ്പരം ബന്ധി/ിക്കുന്ന UTP സേകബിള്‍ 

➢ ഡിജിറ്റല്‍ സിഗ്നലിനെ� അ�ചലോഗോയും തിരിച്ചും *ോറ്റോന്‍ കഴിവുള്ള ഉപകരണം

➢ വിവരകൈകമാ�ം �ിയന്ത്രിക്കുന്ന ഉപകരണം

➢ UTP സേകബിFിലെ� കമ്പ്യൂട്ടറുമായി ബന്ധി/ിക്കുന്ന കണക്ടര്‍

15. വിവരങ്ങള്‍ പരസ്പരം കൈകമാറത്തക്ക വിധത്തില്‍ കമ്പ്യൂട്ടറുകലെF ബന്ധി/ിക്കുന്ന 

�ംവിധാ�ത്തിലെന്റ സേപലെരന്ത് ? 

➢ കമ്പ്യൂ-ര്‍ നെ�റ്റ് വര്‍ക്കിങ് 

➢ സേyാഗ്

➢ ഫയല്‍�ിസ്റ്റം

➢ ഓ/സേറ�ിങ് �ിസ്റ്റം

16. �ന്നിരിക്കുന്നവയില്‍ IPv4 സേപ്രാസേട്ടാസേക്കാള്‍ പ്രകാരമുള്ള ഐ. പി. അഡ്രസ്സാകുവാന്‍ 

�ാധ്യ�യുള്ള�് ഏ�് ?

➢ 192.168.200.256

➢ 92.168.256.10

➢ 192.168.256.200

➢ 192.168.222.10

17. കമ്പ്യൂട്ടറുകള്‍ ലെ��് വര്‍ക്ക് ലെ�യ്യുന്ന�ിലെന്റ ഭാഗമായി UTP സേകബിളുകള്‍ ചുവലെ; 

ലെകാടുത്തിരിക്കുന്ന ഏ�് കണക്ടര്‍ ഉപസേയാഗിച്ചാണ് കമ്പ്യൂട്ടറുകളുമായി 

ബന്ധി/ിക്കാറുള്ള�് ?
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➢ RJ 11

➢ ഹബ്

➢ �്വിച്ച്

➢ RJ 45

➢ 18. ചുവലെ; ലെകാടുത്തിരിക്കുന്ന ഏ�് ഉപകരണലെത്ത സേമാഡവുമായി 

ബന്ധി/ിക്കുന്ന�ി�ാണ് �ാധാരണയായി RJ 11 കണക്ടര്‍  ഉപസേയാഗിക്കുന്ന�്? 

➢ പ്രിന്റര്‍

➢  �്വിച്ച്

➢ കംമ്പ്യൂട്ടര്‍

➢ നെCലിചഫോണ്‍

19.  കമ്പ്യൂട്ടറുകള്‍ ലെ��് വര്‍ക്കിസേലക്ക് പ്രസേവശിക്കുസേമ്പാള്‍ �്വസേമധയാ (Automatic) Automatic) ) 

ഐ.പി വിലാ�ം ലഭ്യമാകുന്ന �സേr�ം ഏ�് ?

➢ SSH

➢ SMB

➢ DHCP

➢ POP

20. ഒരു രാജ്യം മുഴുവന്‍ വ്യാപിച്ചുകി;ക്കുന്ന കമ്പ്യൂട്ടറുകലെF പരസ്പരം ബന്ധി/ിക്കുന്ന 

ലെ��് വര്‍ക്കി�് പറയുന്ന സേപലെരന്താണ് ? 

➢ WAN

➢ LAN

➢ MAN

➢ RAM
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STANDARD X INFORMATION TECHNOLGY

UNIT 6: COMPILED BY:  BY HOWLATH K; HST ARABIC, CKHS MANIMOOLY

1. സണ്‍ക്ലോക്ക് ക്ലസോഫ് റ്റ് വെയറിവെ ക്ലസോളോര്‍ ടൈം ക്ലോഡ് ( S ) ടൂളിവെ ഉപക്ലയോഗം സൂചിപ്പിക്കുന്ന  
ശരിയോയ പ്രസ്തോന ചുവെ വെ-ോടുത്തിരിക്കുന്നയില്‍ നിന്ന് തിരവെ2ടുക്കു- ?  

➢ ചന്ദ്രവെ സ്ഥോനവെത്ത അിസ്ഥോനോക്കി  ഒരു പ്രക്ല9ശവെത്ത സയം പ്ര9ര്‍ശിപ്പിക്കുന്നതിന്

➢ ോല്‍നക്ഷത്രത്തിവെ സ്ഥോനവെത്ത അിസ്ഥോനോക്കി ഒരു പ്രക്ല9ശവെത്ത സയം പ്ര9ര്‍
പ്പിക്കുന്നതിന്

➢ സൂര്യവെ സ്ഥോനവെത്ത അിസ്ഥോനോക്കി ഒരു പ്രക്ല9ശവെത്ത സയം പ്ര9ര്‍ശിപ്പിക്കുന്നതിന്   

➢ ഗ്രീന്‍ിച്ച് ക്ലരഖവെയ അിസ്ഥോനോക്കി ഒരു പ്രക്ല9ശത്തിവെ സ്റ്റോന്‍ക്ലഡര്‍ഡ് സയം പ്ര9ര്‍
പ്പിക്കുന്നതിന്

2. രോവും പ-ലും ക്ലപോലുള്ള ഭൗ സിക്ലസഷത-വെള കുറിച്ചും ിിധ രോജ്യ ങ്ങളിവെ ്യത്യസ്ത 
സയക്ലഖ-വെള കുറിച്ചും നസ്സിോക്കോന്‍ ചുവെ നല്‍-ിയിരിക്കുന്നതില്‍  ഏത് 
ക്ലസോഫ് റ്റ് വെയറോണ് അനുക്ലയോജ്യം?     

➢ GeoGebra     

➢ Sunclock         

➢ gis        

➢ Inkscape
3.നല്‍-ിയിരിക്കുന്ന Sunclock ോപ്പിവെ ചിത്രത്തിവെ നിഴലും വെളിച്ചവും ിശ-നം വെചയ്ത്  
പ-ിവെ ടൈ9ര്‍ഘ്യം ഏറ്റവും കൂടുതല്‍ അനുഭവെപ്പടുന്ന പ്രക്ല9ശം ചുവെയുള്ളയില്‍ നിന്നു 
തിരവെ2ടുക്കു-. 

➢ ഉത്തരധ്രുത്തിക്ലനോ്  ക്ലചര്‍ന്ന പ്രക്ല9ശത്ത് 

➢ ദക്ഷിണ ധ്രുവത്തിന*ോട് ന.ര്‍ന്ന പ്രനദശത്ത് 

➢ ഭൂധ്യക്ലരഖക്ലയോ് ക്ലചര്‍ന്ന പ്രക്ല9ശത്ത് 

➢ ഉത്തരോയനക്ലരഖക്ലയോ് ക്ലചര്‍ന്ന പ്രക്ല9ശത്ത് 
4.നല്‍-ിയിരിക്കുന്ന Sunclock ോപ്പിവെ ചിത്രത്തിവെ നിഴലും വെളിച്ചവും ിശ-നം വെചയ്ത്  
സൂര്യവെ സ്ഥോനം എിവെയോവെണന്ന് ചുവെയുള്ളയില്‍ നിന്നു തിരവെ2ടുക്കു-.

➢ ഉത്തരധ്രുത്തിക്ലനോ്  ക്ലചര്‍ന്ന പ്രക്ല9ശത്ത് 

➢ 9ക്ഷിണ ധ്രുത്തിക്ലനോ് ക്ലചര്‍ന്ന പ്രക്ല9ശത്ത് 



➢ ഭൂമധ്യന7ഖന9ോട് ന.ര്‍ന്ന പ്രനദശത്ത് 

➢ ഉത്തരോയനക്ലരഖക്ലയോ് ക്ലചര്‍ന്ന പ്രക്ല9ശത്ത് 

5.നല്‍-ിയിരിക്കുന്ന Sunclock ോപ്പിവെ ചിത്രത്തിവെ നിഴലും വെളിച്ചവും ിശ-നം വെചയ്ത്  
പ-ിവെ ടൈ9ര്‍ഘ്യം ഏറ്റവും കൂടുതല്‍ അനുഭവെപ്പടുന്ന പ്രക്ല9ശം ചുവെയുള്ളയില്‍ നിന്നു 
തിരവെ2ടുക്കു-

➢ ഉത്ത7ധ്രുവത്തിന*ോട്  ന.ര്‍ന്ന പ്രനദശത്ത് 

➢ 9ക്ഷിണ ധ്രുത്തിക്ലനോ് ക്ലചര്‍ന്ന പ്രക്ല9ശത്ത് 

➢ ഭൂധ്യക്ലരഖക്ലയോ് ക്ലചര്‍ന്ന പ്രക്ല9ശത്ത് 

➢ 9ക്ഷിണോയനക്ലരഖക്ലയോ് ക്ലചര്‍ന്ന പ്രക്ല9ശത്ത് 
6.സണ്‍ക്ലോക്ക് ക്ലസോഫ് റ്റ് വെയറിവെ വെനുബോറിവെ  ക്ലോഗിള്‍ ടൈനറ്റ് (N) ) ടൂളിവെ ഉപക്ലയോഗം 
സൂചിപ്പിക്കുന്ന  ശരിയോയ പ്രസ്തോന ചുവെ വെ-ോടുത്തിരിക്കുന്നയില്‍ നിന്ന് തിരവെ2ടുക്കു- ?  

➢ രോത്രിയുക്ലയും പ-ിക്ലയും സയടൈ9ര്‍ഘ്യം-ോണുന്നതിനും ഒഴിോക്കുന്നതിനും

➢ രോത്രിയില്‍ ദൃശ്യോകുന്ന നക്ഷത്രങ്ങവെള -ോണുന്നതിനും ഒഴിോക്കുന്നതിനും 

➢ രോത്രിയുക്ലയും പ-ിക്ലയും സയക്ലഖ-ള്‍ -ോണുന്നതിനും ഒഴിോക്കുന്നതിനും

➢ 7ോത്രിയുനടയും പകലിനAയും നവര്‍തി7ിവ്  കോണുന്നതിനും ഒഴിവോക്കുന്നതിനും

7.സണ്‍ക്ലോക്ക് ക്ലസോഫ് റ്റ് വെയറിവെ വെനുബോറിവെ  ക്ലോഗിള്‍ സണ്‍/മൂണ്‍ (Y) ) ടൂളിവെ ഉപക്ലയോഗം 
സൂചിപ്പിക്കുന്ന ഏറ്റവും ശരിയോയ പ്രസ്തോന ചുവെ വെ-ോടുത്തിരിക്കുന്നയില്‍ നിന്ന് തിരവെ2ടുക്കു- 

➢ സൂര്യവെനയും ചന്ദ്രവെനയും ദൃശ്യോക്കുന്നതിന്  

➢ സൂ7്യന*യും .ന്ദ്രന*യും  ദൃശ്യമോക്കുന്നതിനും അദൃശ്യമോക്കുന്നതിനും

➢ സൂര്യവെന ോത്രം ദൃശ്യോക്കുന്നതിന് 

➢ ചന്ദ്രവെന ോത്രം ദൃശ്യോക്കുന്നതിന് 
8.സണ്‍ക്ലോക്ക് ക്ലസോഫ് റ്റ് വെയറിവെ   ക്ലോഗിള്‍ വെറിഡിയന്‍ (M) ) ടൂളിവെ ഉപക്ലയോഗം സൂചിപ്പിക്കുന്ന 
ഏറ്റവും ശരിയോയ പ്രസ്തോന ചുവെ വെ-ോടുത്തി രിക്കുന്നയില്‍ നിന്ന് തിരവെ2ടുക്കു- ?

➢ പ്രധോന അക്ഷോംശക്ലരഖ-ള്‍ ദൃശ്യോക്കോനും അദൃശ്യോക്കോനും

➢ സയക്ലഖ-ള്‍  ദൃശ്യോക്കോനും അദൃശ്യോക്കോനും

➢ ക്ലരഖോംശക്ലരഖ-ള്‍ ദൃശ്യോക്കോനും അദൃശ്യോക്കോനും



➢ അക്ഷോംശക്ലരഖ-ള്‍ ദൃശ്യോക്കോനും അദൃശ്യോക്കോനും

➢ ക്ലരഖോംശക്ലരഖ-ള്‍ ദൃശ്യോക്കോനും അദൃശ്യോക്കോനും
9. തോവെഴ വെ-ോടുത്തിരിക്കുന്നയില്‍ ഏതോണ്  ഉപക്ലയോക്തോക്കളില്‍ നിന്നുള്ള ിരങ്ങള്‍ 
അിസ്ഥോനോക്കി തയ്യോറോക്കിയ ഓണ്‍ടൈന്‍ ഭൂപ സംിധോനം ? 

➢ വിക്കിമോപ്പി9  

➢ ിക്കിപീഡിയ  

➢ ജിക്ലയോജിബ്ര    

➢ സണ്‍ക്ലോക്ക്
10.ഉപക്ലയോക്തോക്കളില്‍ നിന്നുള്ള ിരങ്ങള്‍ അിസ്ഥോനോക്കി തയ്യോറോക്കിയ ഓണ്‍ടൈന്‍ ഭൂപ 
സംിധോനം അല്ലോത്തത് ചുവെ വെ-ോടുത്തിരിക്കുന്നയില്‍ നിന്ന് തിരവെ2ടുക്കു-  ?

➢ ിക്കിോപ്പിയ 

➢ ഗൂഗിള്‍ ോപ്പ്   

➢ ഓപ്പണ്‍ സ്ട്രീറ്റ് ോപ്പ്   

➢ സണ്‍നPോക്ക്

11 .ഭൂിയുവെ ഉപരിത സിക്ലശഷത-ളും സ്ഥോനീയിരങ്ങളും ഭൂപങ്ങളോയും ിരങ്ങളോയും 
ക്ലശഖരിച്ച് ിശ-നത്തിന് പ്രക്ലയോജനവെപ്പടുത്തോന്‍ കഴി9ോത്ത  ക്ലസോഫ് റ്റ് വെയര്‍ ചുവെ നല്‍
-ിയിരിക്കുന്നയില്‍ നിന്ന് തിരവെ2ടുക്കു- ?

➢ Quantum GIS  

➢ GRASS    

➢ Arc GIS  

➢ Sunclock

12.ഡിജിറ്റല്‍ ഭൂപങ്ങളുോയി ന9ോജിക്കോത്ത പ്രസ്തോന ചുവെ വെ-ോടുത്തിട്ട ള്ളയില്‍ നിന്ന് 
തിരവെ2ടുക്കു- ?

➢ ിിധ ക്ലഖ-ളുവെ ിരങ്ങള്‍ പ്രക്ലത്യ- പോളി-ളിോയി ക്ലരഖവെപ്പടുത്തുന്നു

➢ ഭൗക്ലോപരിതത്തിലുണ്ടോവുന്ന ോറ്റങ്ങള്‍
-ോിളംബം കൂോവെത ദൃശ്യോക്കുന്നു

➢ സൂക്ഷ ്ോയും കൃത്യോയും പ്രക്ല9ശങ്ങവെള ക്ലരഖവെപ്പടുത്തുന്നു

➢ ആകോശത്തിലുണ്ടോവുന്ന മോറ്റങ്ങള്‍ കോലവിളംബം കൂടോതെത ദൃശ്യമോക്കുന്നു

13 .ജനോസ ക്ല-ന്ദ്രത്തിലൂവെ -ന്നുക്ലപോകുന്ന ഒരു ക്ലറോഡ് പത്ത് ീറ്റര്‍ ീതി കൂട്ടു- യോവെണങ്കില്‍ 
ഏവെതല്ലോം വെ-ട്ടിങ്ങവെള ബോധിക്കുവെന്ന് -വെണ്ടത്തോന്‍ Quantum  GIS ക്ലസോഫ് റ്റ് വെയറിവെ ഏത് 
സക്ലങ്കതോണ് പ്രക്ലയോജന വെപ്പടുത്തോവുന്നത് ?

➢ Buffer   

➢ N) ew Print Composer  



➢ Toggle Editing

➢ Add Feature
14. -്യുജിസ് ക്ലസോഫ്റ്റ് വെയറില്‍ തുറന്ന ഭൂപത്തിവെ, വെക്ലയര്‍സ് പോനില്‍ നിന്നും ഒരു വെയറില്‍ 
ടൈററ്റ് ിക്ക് വെചയ്ത് Open Attribute Table തുറന്നോല്‍ ഭിക്കുന്ന ജോ-ം ഏതോണ്?

➢ തെല9റിതെല സ്ഥോ*ീ9വിവ7ങ്ങളുതെട വിനശഷണങ്ങള്‍ കോണിക്കുന്ന ജോലകം

➢ വെയറിവെ നിറം ോറ്റുന്നതിനുള്ള ജോ-ം

➢ വെയര്‍ ടൈപ്പ് ോറ്റുന്നതിനുള്ള ജോ-ം

➢ വെയര്‍ ടൈപ്പിവെ -നം ്യത്യോസവെപ്പടുത്തുന്നതിനുള്ള ജോ-ം
A വെയറിവെ സ്ഥോനീയിരങ്ങളുവെ ിക്ലശഷണങ്ങള്‍ -ോണിക്കുന്ന ജോ-ം

15. -്യുജിസ് ഭൂപത്തിവെ ഒരു വെയറിവെ സ്ഥോനീയ ിരത്തിവെ ിക്ലശഷ ണങ്ങള്‍ പ്ര9ര്‍
ശിപ്പിക്കുന്നതിനുള്ള ോര്‍ഗം ചുവെ വെ-ോടുത്തിട്ടുള്ളയില്‍ നിന്ന് തിരവെ2ടുക്കു- ?

➢ തെല9റില്‍ റൈററ്റ് Pിക്ക് തെ.യ്ത്  Open Attribute Table തുറക്കുക

➢ വെയറില്‍ ടൈററ്റ് ിക്ക് വെചയ്ത്  Toggle Editing തുറക്കു-

➢ വെയറില്‍ ടൈററ്റ് ിക്ക് വെചയ്ത്  Filter തുറക്കു-

➢ വെയറില്‍ ടൈററ്റ് ിക്ക് വെചയ്ത്  Properties തുറക്കു-
 16. Quantum GIS ക്ലസോഫ് റ്റ് വെയറില്‍ തയോറോക്കുന്ന ഒരു ിഭഭൂപത്തില്‍ ന9ി-വെള  
അയോളവെപ്പടുത്തോനോയി ചുവെ വെ-ോടുത്തിരിക്കുന്നയില്‍ ഏതുതരം വെയര്‍  ടൈപ്പോണ്  
ഉപക്ലയോഗിക്ലക്കണ്ടത് ?

➢ Point  

➢ Line   

➢ Polygon    

➢ Circle
17 .Quantum GIS  ക്ലസോഫ് റ്റ് വെയറില്‍ പോളി-ളോയി ഉപക്ലയോഗിക്കുന്ന ഫയലു -ളുവെ  (layers)  
എ-് സ് റ്റന്‍ഷന്‍ ഏതോണ് ?

➢ .qgs  

➢ .pdf      

➢ .shp    

➢ .odb
 18 .-്യുജിസ് ക്ലസോഫ്റ്റ് വെയറില്‍ ്യത്യസ്ത പോളി-ളോയി ക്ലചര്‍ക്കുന്ന സ്ഥോനീയ ിരങ്ങളുവെ വെയര്‍ 
ടൈപ്പ് ആ-ോന്‍ സോധ്യതയില്ലോത്ത ജ്യോിതീയ രൂപം ചുവെ വെ-ോടുത്തിട്ടുള്ളയില്‍ നിന്ന് 
തിരവെ2ടുക്കു- ?

➢ ബിന്ദു ( Point )   

➢ വൃത്തം ( Circle )     



➢ ര ( Line )

➢ ബഹുഭുജം ( Polygon )
 19. -്യുജിസ് ക്ലസോഫ്റ്റ് വെയറില്‍ ്യത്യസ്ത പോളി-ളോയി ക്ലചര്‍ക്കുന്ന സ്ഥോനീയ ിരങ്ങളുവെ വെയര്‍ 
ടൈപ്പിവെന സംബന്ധിച്ച  പ്രസ്തോന-ള്‍ നിരീക്ഷിച്ച ക്ലശഷം  തെതറ്റോ9 പ്രസ്തോവ* തിരവെ2ടുക്കു- ?

➢ ീ്, -ിണര്‍ തുങ്ങിയ  ബിന്ദുോയി ( Point ) അയോളവെപ്പടുത്തണം

➢ കുളം , തടോകം തുടങ്ങി9വ വൃത്തങ്ങളോ9ി  ( Circle ) അട9ോളതെപ്പടുത്തണം

➢ ക്ലറോഡ്, ന9ി തുങ്ങിയ  ര-ളോയി ( Line ) അയോളവെപ്പടുത്തണം

➢ അതിരു-ള്‍ , സര്‍ക്ല ക്ല¨ോട്ടു-ള്‍ തുങ്ങിയ ബഹുഭുജോയി ( Polygon ) 
അയോളവെപ്പടുത്തണം

Q N) o: 20
ഭൂിര ക്ലസോഫ്റ്റ് വെയറു-ളുോയി ( Geographical Information System Software ) ന9ോജിക്കോത്ത 
പ്രസ്തോന ചുവെ വെ-ോടുത്തിട്ടുള്ളയില്‍ നിന്ന് തിരവെ2ടുക്കു-.

➢ ഭൗക്ലോപരിതത്തിവെ സ്ഥോനീയ ിരങ്ങള്‍ിിധ പോളി-ളിോയി ക്ലരഖവെപ്പടുത്തോന്‍
ഭൂിര ക്ലസോഫ്റ്റ് വെയറു-ളില്‍  സോധിക്കും

➢ ളവെരയധി-ം ിരങ്ങള്‍ ക്ലശഖരിക്കോനും ിശ-നം വെചയ്യോനും ഭൂിര ക്ലസോഫ്റ്റ് വെയറു-ള്‍
ക്ക് -ഴിയും

➢ Quantum GIS, GRASS , Arc GIS എന്നി പ്രമുഖ ഭൂിര ക്ലസോഫ്റ്റ് വെയറു-ളു-ളോണ്

➢ ഇവ9ില്‍ GRASS എന്നത്  സ്വതന്ത്ര ഭൂവിവ7 നസോഫ്റ്റ് തെവ9റോണ്

21. തോവെഴ വെ-ോടുത്തിരിക്കുന്നയില്‍ ഏതോണ് ഒരു ഓണ്‍ടൈന്‍ ഭൂപസംിധോനം അല്ലോത്തത് ?

➢ ിക്കിോപ്പിയ 

➢ ഗൂഗിള്‍ ോപ്പ്    

➢ ഓപ്പണ്‍ സ്ട്രീറ്റ് ോപ്പ്

➢ സണ്‍നPോക്ക്

22.ചുവെ നല്‍-ിയിരിക്കുന്നയില്‍ ഏതോണ് ഒരു ഭൂിര്യസ്ഥോ ക്ലസോഫ് റ്റ് വെയര്‍ (Geographical 
Information System) ?

➢ GeoGebra  

➢ Inkscape      

➢ Quantum GIS 

➢ Python

23. ചുവെ നല്‍-ിയിരിക്കുന്നയില്‍ ഏതോണ് ഒരു ഭൂിര്യസ്ഥോ ക്ലസോഫ് റ്റ് വെയര്‍ (Geographical
Information System) അല്ലോത്തത് ?



➢ Quantum GIS  B

➢ GRASS   C   

➢ Arc GIS     

➢ Wikipedia

24. Quantum GIS ക്ലസോഫ് റ്റ് വെയറില്‍ തയോറോക്കുന്ന ഒരു ിഭഭൂപത്തില്‍ ക്ലറോഡു-വെള 
അയോളവെപ്പടുത്തോനോയി ചുവെ വെ-ോടുത്തിരിക്കുന്നയില്‍ ഏതുതരം വെയര്‍  ടൈപ്പോണ്  
ഉപക്ലയോഗിക്ലക്കണ്ടത് ?

➢ Point  

➢ Line    

➢ Polygon     

➢ Circle
25. Quantum GIS ക്ലസോഫ് റ്റ് വെയറില്‍ തയോറോക്കുന്ന ഒരു ിഭഭൂപത്തില്‍ തോ-ങ്ങള്‍ 
അയോളവെപ്പടുത്തോനോയി ചുവെ വെ-ോടുത്തിരിക്കുന്നയില്‍ ഏതുതരം വെയര്‍  ടൈപ്പോണ് 
ഉപക്ലയോഗിക്ലക്കണ്ടത് ?

➢ Point 

➢ Line     

➢ Polygon    

➢ Circle
SHORT ANSWER TYPE QUESTIONS

1. സണ്‍ക്ലോക്ക് ക്ലസോഫ് റ്റ് വെയറില്‍ സയക്ലഖോ ഭൂപത്തില്‍ സൂര്യവെ സ്ഥോനം പ്രധോന 
വെപ്പട്ട അക്ഷോംശക്ലരഖ-വെള അിസ്ഥോനവെപ്പടുത്തി -വെണ്ടത്തുന്ന പ്രര്‍ത്തനക്രം 

തോവെഴപ്പറയുന്നയില്‍ നിന്ന് -വെണ്ടത്തു-.

ക്ലഫോര്‍ക്ലഡ് ടൈം ടൂള്‍ (A) A) ) ിക്ക് വെചയ്യു-

➢ നടോഗിള്‍ ന‚ോപിക്ക് (T) T) ) ടൂള്‍ Pിക്ക് തെ.യ്യുക

➢ ക്ലോഗിള്‍ വെറീഡിയന്‍(A) M) ) ടൂള്‍ ിക്ക് വെചയ്യു-

➢ ക്ലസോളോര്‍ ടൈം ടൂള്‍ (A) S) ) ിക്ക് വെചയ്യു-

➢ നടോഗിള്‍ സണ്‍/മൂണ്‍ (T) Y) ) ടൂള്‍ Pിക്ക് തെ.യ്യുക

2.സണ്‍ക്ലോക്ക് ക്ലസോഫ് റ്റ് വെയറിവെ ഉപക്ലയോഗവെത്ത സംബന്ധിച്ച് ചുവെ വെ-ോടുത്തിരിക്കുന്ന 

പ്രസ്തോന-ളില്‍ നിന്നും വെതറ്റോയ രണ്ടു  രവെണ്ടണ്ണം തിര2ടുക്കു-.

➢ *ക്ഷത്ര സമൂഹങ്ങതെളക്കുറിച്ച് മ*സ്സിലോക്കോന്‍



പ്രധോനവെപ്പട്ട അക്ഷോംശക്ലരഖ-ളും ക്ലരഖോംശക്ലരഖ-ളും നസിോക്കോന്‍ 

➢ സൂര്യവെ അയനങ്ങവെളക്കുറിച്ച് നസ്സിോക്കോന്‍ 

➢ ഒരു പ്രനദശത്തിതെA വിഭവഭൂപടം യ്യോറോക്കുന്നതി*് 

➢ ഭൂിയിവെ സയക്ലഖ-വെളക്കുറിച്ച് നസ്സിോക്കോന്‍ 

3.ഭൂിര ്യസ്ഥ ക്ലസോഫ് റ്റ് വെയറിവെ (A) Geographical Information S) ystem) 

ഉപക്ലയോഗവെത്ത സംബന്ധിച്ച് ചുവെ വെ-ോടുത്തിരി ക്കുന്ന പ്രസ്തോന-ളില്‍ നിന്നുംവെതറ്റോയ 

രവെണ്ടണ്ണം -വെണ്ടത്തു-. ?

➢ ഒരു പ്രക്ല9ശത്തിവെ സഗ്ര ിഭഭൂപം തയ്യോറോക്കുന്നതിന് ഉപക്ലയോഗവെപ്പടുത്തോം.

➢ *ക്ഷത്രങ്ങതെളക്കുറിച്ചുള്ള വിവ7ങ്ങള്‍ മ*സ്സിലോക്കോന്‍ ഉപന9ോഗതെപ്പടുത്തോം.

➢ ഭൗക്ലോപരിതത്തിവെ സിക്ലശഷത-ക്ലളയും സ്ഥോനീയ ിരങ്ങക്ലളയും 
ക്ലരഖവെപ്പടുത്തുന്നതിന് 

➢ ഭുപങ്ങക്ലളയും ിരങ്ങക്ലളയും ിശ-നും വെചയ്യോനും ക്ലക്രോഡീ-രിക്കോനും 

➢ വ്യത്യസ്ത സമ9നമഖലകതെളക്കുറിച്ച് മ*സ്സിലോക്കോന്‍ 

4.സണ്‍ക്ലോക്ക് ക്ലസോഫ്റ്റ് വെയറില്‍ ക്ലോഗിള്‍ വെനറ്റ് (A) N) ) ടൂളി ഉപ ക്ലയോഗവെത്തക്കുറിച്ച് ചുവെ 

വെ-ോടുത്തിരിക്കുന്ന പ്രസ്തോന-ളില്‍ നിന്നും ശരിയോയ രണ്ടു പ്രസ്തോന-ള്‍ -വെണ്ടത്തു-. 

➢ ഒരു പ്രക്ല9ശത്തിവെ പ്രോക്ല9ശി- സയം പ്ര9ര്‍ശിപ്പിക്കോന്‍ 

➢ 7ോത്രിയുനടയും പകലിനAയും നവര്‍തി7ിവ് ദൃശ്യമോക്കോന്‍ 

➢ പ്രധോന അക്ഷോംശക്ലരഖ-ള്‍ പ്ര9ര്‍ശിപ്പിക്കോന്‍ 

➢ 7ോത്രിയുനടയും പകലിനAയും നവര്‍തി7ിവ് അദൃശ്യമോക്കോന്‍ 

➢ സയം ക്രീ-രിക്കോന്‍ 

5.ഭൂിര ്യസ്ഥ ക്ലസോഫ് റ്റ് വെയറിവെ  (A) Geographical Information S) ystem) 

ഉപക്ലയോഗവെത്ത സംബന്ധിച്ച് ചുവെ വെ-ോടുത്തിരിക്കുന്ന പ്രസ്തോന-ളില്‍ നിന്നും ശരിയോയ  

രണ്ടു പ്രസ്തോന-ള്‍ -വെണ്ടത്തു-. 

➢ ്യത്യസ്ത സയക്ലഖ-വെളക്കുറിച്ച് നസ്സിോക്കോന്‍ 

➢ ഭൗനമോപ7ിതലത്തിതെല സവിനശഷതകനളയും സ്ഥോ*ീ9 വിവ7ങ്ങനളയും 

ന7ഖതെപ്പടുത്തുന്നതി*്.

➢ നക്ഷത്രങ്ങവെളക്കുറിച്ചുള്ള ിരങ്ങള്‍ നസ്സിോക്കോന്‍

➢ സൂര്യവെ അയനങ്ങവെളക്കുറിച്ച് നസ്സിോക്കോന്‍ 



➢ ഒരു പ്രനദശത്തിതെA സമഗ്ര വിഭവഭൂപടം തയ്യോറോക്കുന്നതി*് 

6. -്വോണ്ടം ജി.ഐ.എസ് (A) Quantum GIS) ) ക്ലസോഫ്റ്റ് യറില്‍ വെയര്‍  ടൈപ്പ്, ക്ലപോയി് 

(A) Point)  ഉപക്ലയോഗിച്ച് അയോളവെപ്പടുത്തോവുന്ന രണ്ട് ിരങ്ങള്‍ ചുവെ 

വെ-ോടുത്തിരിക്കുന്നയില്‍ നിന്നും -വെണ്ടത്തു-.

➢ വീട് 

➢ ജില്ല
➢ ക്ലറോഡ്
➢ കിണര്‍

7.-്വോണ്ടം ജി.ഐ.എസ് (A) Quantum GIS) ) ക്ലസോഫ്റ്റ് യറില്‍ വെയര്‍  ടൈപ്പ്, ടൈന്‍ (A) Line) 

ഉപക്ലയോഗിച്ച് അയോളവെപ്പടുത്തോവുന്ന രണ്ട് ിരങ്ങള്‍ ചുവെ വെ-ോടുത്തിരിക്കുന്നയില്‍ 

നിന്നും -വെണ്ടത്തു-.

➢ ീ്
➢ ജില്ല
➢ നറോഡ്

➢ -ിണര്‍

➢ *ദി

8.സണ്‍ക്ലോക്ക് ക്ലസോഫ്റ്റ് വെയറില്‍ ക്ലോഗിള്‍ ക്ലµോപി-്/ ഇക്ല-്വറ്റര്‍/ആര്‍ട്ടി-് ടൂളി (A) T) ) 

ഉപക്ലയോഗവെത്തക്കുറിച്ച്  ചുവെ വെ-ോടുത്തിരിക്കുനയില്‍ നിന്നും ശരിയോയ രണ്ടു പ്രസ്തോ-ള്‍ 

-വെണ്ടത്തു-. 

➢ ഉത്ത7ോ9*-ദക്ഷിണോ9* ന7ഖകള്‍ പ്രദര്‍ശിപ്പിക്കോന്‍ ഉപന9ോഗിക്കുന്നു.

➢  രോത്രിയുക്ലയും പ-ിക്ലയും ക്ലര്‍തിരി് പ്ര9ര്‍ശിപ്പിക്കോന്‍ ഉപക്ലയോഗിക്കുന്നു.

➢ ഭുമധ്യന7ഖതെ9 ദൃശ്യമോക്കോന്‍ ഉപന9ോഗിക്കുന്നു.

➢ സൂര്യവെനയും ചന്ദ്രക്ലനയും ദൃശ്യോക്കോന്‍ ഉപക്ലയോഗിക്കുന്നു.

➢ ഒരു പ്രക്ല9ശത്തിവെ പ്രോക്ല9ശി- സയം പ്ര9ര്‍ശിപ്പിക്കോന്‍ ഉപക്ലയോഗിക്കുന്നു.

9. -്വോണ്ടം ജി.ഐ.എസ് (A) Quantum GIS) ) ക്ലസോഫ്റ്റ് യറില്‍ ഭൂപം പ്രി് വെചയ്യോനുള്ള രണ്ട്

ഘട്ടങ്ങള്‍ ചുവെ വെ-ോടുത്തിരിക്കുന്ന പ്രസ്തോന-ളില്‍ നിന്നും -വെണ്ടത്തു-.

➢ Project  New Print Composer    Add new map→ New Print Composer  →  Add new map → New Print Composer  →  Add new map

➢ Layer    Create Layer   N) ew S) hape file Layer→ Create Layer  → New Shape file Layer → Create Layer  → New Shape file Layer



➢ Vector   Geo processing tools  Buffers→ Create Layer  → New Shape file Layer → Create Layer  → New Shape file Layer

➢ ഭൂപടത്തി*ോവശ്യമോ9 വിവ7ങ്ങള്‍ ന.ര്‍ത്ത്  Composer  Exports as → New Print Composer  →  Add new map

➢ Layer    A) dd Layer → Create Layer  → New Shape file Layer

10.  -്വോണ്ടം ജി.ഐ.എസ് (A) Quantum GIS) ) ക്ലസോഫ്റ്റ് വെയറില്‍ വെയര്‍ ടൈപ്പ് , 

ക്ലപോളിഗണ്‍ (A) Polygon)  ഉപക്ലയോഗിച്ച് അയോള വെപ്പടുത്തോവുന്ന ണ്ട് ിരങ്ങള്‍ ചുവെ 

വെ-ോടുത്തിരിക്കുന്ന യില്‍നിന്നും -വെണ്ടത്തു-.

➢ ന9ി
➢ തടോകം

➢ ക്ലറോഡ്
➢ -ിണര്‍

➢ അതിരുകള്‍



     STANDARD 10 – INFORMATION TECHNOLOGY – UNIT 7:ഇന്റര്‍നെ�റ്റ് പ്രവര്‍ത്തിക്കുന്നനെ%ങ്ങനെ�
 %ിയറി ച*ോദ്യങ്ങളും ഉത്തരങ്ങളും  

1. ഇന്റര്‍നെ�റ്റ് പ്ര�ോപ്ര�ോപ്ര�ോളു�ളുനെ� �വീ�രണങ്ങള്‍ പരിപ്ര�ോധിച്ച് അംഗീ�രിക്കുന്ന 
സംഘ��യോണ് IETF .
ഇതിനെന്റ പൂര്‍ണരൂപം എന്തോണ്  ?

➢ Internet Environment Task Force

➢ Internet Engineering Task Force   

➢ Internet Enterprises Task Force

➢ Internet Equipments Task Force

2. നെവബ് വിലോസങ്ങള്‍ �മ്പ്യൂ�റു�ള്‍ക്ക് തിരിച്ചറിയോവുന്ന ഐ. പി. വിലോസങ്ങളോയും 
തിരിച്ചും മോറ്റിനെയടുക്കുന്നതിനുള്ള സംവിധോ�ത്തിനു പറയുന്ന പ്രപനെരന്ത് ?  

➢ DNS

➢ HTTP

➢ WWW

➢ IP

3. പ്രവള്‍ഡ് വൈവഡ് നെവബിനെന്റ (www) www) ഉപജ്ഞോതോവ് ആര് ?  

➢ ലിസ് ലി ലോംപ്രപോര്‍�്

➢ റിച്ചോര്‍ഡ് മോത്യു സ്റ്റോള്‍മോന്‍

➢ ടിം നെ3ര്‍ച4ഴ്സ് ലീ

➢ നെഡോണോള്‍ഡ് �് നൂത്ത്

4. ഓണ്‍വൈലന്‍ ഇ�പോടു�നെള കൂടുതല്‍ സുരക്ഷിതമോക്കോന്‍ ഉപപ്രയോഗിക്കുന്ന സപ്രhതം 
ചുവനെ� നെ�ോടുത്തിട്ടുള്ളവയില്‍ ഏത് ?

➢ IP

➢ WWW

➢ URL

➢ OTP
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5. നെവബ്വൈസറ്റു�ളുനെ� IP വിലോസങ്ങനെള �മുക്ക് ഓര്‍ക്കോന്‍ എളുപ്പമുള്ള പ്രപരു�ളോയി 
മോറ്റി ഉപപ്രയോഗിക്കോറുണ്ട്. ഇത് ഏത് പ്രപരിലോണ് അറിയനെപ്പടുന്നത്  ?

➢ നെഡോവൈമന്‍  �ോമം  

➢ വൈuപ്പര്‍ �ോമം

➢ നെവബ് �ോമം

➢ റിപ്രസോഴ് സ് �ോമം

6. ചുവനെ� നെ�ോടുത്തിരിക്കുന്നവയില്‍ ഏത് പ്ര�ോപ്ര�ോപ്ര�ോള്‍ ഉപപ്രയോഗിച്ചോണ് 
world wide web �വര്‍ത്തിക്കുന്നത് ?  

➢ SMTP

➢ HTTP

➢ HTML

➢ SSH

7. https://kite.kerala.gov.in//2020/std10malayalam.pdf എന്ന URL ല്‍ 
സൂചിപ്പിച്ചിരിക്കുന്ന ഫയല്‍ വൈ�മോറ്റ സപ്രhതം ചുവനെ� നെ�ോടുത്തിരിക്കുന്നവയില്‍ 
ഏത് ?  

➢ ssh

➢ https

➢ www

➢ pdf

8. ഇന്റര്‍നെ�റ്റിനെന്റ ഘ��യുപ്ര�യും �യങ്ങളുപ്ര�യും നെപോതുവിഷയങ്ങളുപ്ര�യും പ്രമല്‍പ്ര�ോ�ം 
വuിക്കുന്ന സംഘ��യുനെ� പ്രപനെരന്ത് ?

➢ World Wide Web 

➢ The Internet Engineering Task Force

➢ The Internet Corporation for Assigned Names and Numbers
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➢ The Internet Society

9. https://kite.kerala.gov.in//2020/std10malayalam.pdf എന്ന URL ല്‍ ഫയല്‍ 
ഇരിക്കുന്ന ഇ�ം ഏതോണ് ?  

➢ /www

➢ https

➢ /2020

➢ /pdf

10. ഓണ്‍വൈലന്‍ ഇ�പോടു�നെള കൂടുതല്‍ സുരക്ഷിതമോക്കോന്‍ ഉപപ്രയോഗിക്കുന്ന OTP 
സംവിധോ�ത്തിനെന്റ പൂര്‍രൂപം എന്തോണ് ?

➢ Once Trading Password

➢ Once Testing Password

➢ One Trade Password

➢ One Time Password  

11. നെവബ് വിലോസങ്ങളു മോയി ബന്ധനെപ്പ�് DNS എന്നതിനെന്റ പൂര്‍ണ്ണരൂപം എന്ത് ?

➢ Domain Name Server

➢ Domain Network Server

➢ Data Name Server

➢ Data Network Server

11. എല്ലോ ഇന്റര്‍നെ�റ്റ് വിലോസവും അതിനെന്റ ഐ. പി. വിലോസത്തിപ്രലക്കുതനെന്ന 
എത്തനെപ്പടുന്നു എന്ന് ഉറപ്പുവരുത്തുന്നത് ഏതു സംഘ��യോണ് ? 

➢ The Internet Society (www) ISOC)

➢ The Internet Engineering Task Force (www) IETF)

➢ The Internet Corporation for Assigned Names and Numbers (ICANN)
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➢ World Wide Web (www) WWW)

12. നെവബ്വൈസറ്റു�ളുമോയി ബന്ധനെപ്പ� URL എന്നതിനെന്റ പൂര്‍ണ്ണരൂപം എന്ത് ?

➢ Uniform Resource Location

➢ Uniform Resource Locator

➢ Unified Resource Locator

➢ United Resource Locator

13. HTML ഫയലു�നെള ഇന്റര്‍നെ�റ്റിലൂനെ� വൈ�മോറ്റം നെചയ്യോനുള്ള പ്ര�ോപ്ര�ോപ്ര�ോള്‍ ഏത്  ?

➢ HTP  (www) High Transfer  Protocol)

➢ (HTTP)  Hyper Text Transfer Protocol

➢ (www) FTP)  File Transfer Protocol

➢ (www) DNSP)  Domain Name Server Protocol

14. നെവബ് വൈസറ്റു�ളുമോയി ബന്ധനെപ്പ� �രിയോയ �സ്  തോവ� ചുവനെ� �ല്‍�ിയവയില്‍ 
�ിന്നും തിരനെ�ടുക്കു�

➢ ഒചന്നോ അ%ിലധികചWോ നെവ3്ചXജുകള്‍ 
ച*ര്‍ന്ന%ോ4് ഒരു നെവ3്സൈ^റ്റ്.  

➢ ഒരു നെവബ്വൈസറ്റിനു ഒരു IP വിലോസം 
മോത്രമോണുള്ളത്

➢ നെവബ് വിലോസങ്ങനെള ഐ. പി. വിലോസങ്ങളോയി
 മോറ്റിനെയടുക്കോന്‍ സംവിധോ�മില്ല.

➢ IP വിലോസങ്ങനെള ഓര്‍ക്കോന്‍ എളുപ്പമുള്ള 
പ്രപരു�ളോയി മോറ്റോന്‍ സോധ്യമല്ല.

15. നെവബ് വൈസറ്റു�ളുമോയി ബന്ധനെപ്പ� �രിയോയ �സ്  തോവ� ചുവനെ� �ല്‍�ിയവയില്‍ 
�ിന്നും തിരനെ�ടുക്കു�

➢ ഒരു നെവ3്സൈ^റ്റിനു%നെന്ന ഒന്നിലധികം IP വിലോ^ങ്ങള്‍ ഉണ്ടോയിരിക്കോം.
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➢ ഒരു നെവബ്വൈസറ്റിനു ഒരു IP വിലോസം മോത്രമോണുള്ളത്.

➢ നെവബ് വിലോസങ്ങനെള ഐ. പി. വിലോസങ്ങളോയി  മോറ്റിനെയടുക്കോന്‍ സംവിധോ�മില്ല.

➢ IP വിലോസങ്ങനെള ഓര്‍ക്കോന്‍ എളുപ്പമുള്ള പ്രപരു�ളോയി മോറ്റോന്‍ സോധ്യമല്ല.

16. ഇന്റര്‍നെ�റ്റുമോയി ബന്ധനെപ്പ� �രിയോയ �സ്  തോവ� ചുവനെ� �ല്‍�ിയവയില്‍ �ിന്നും 
തിരനെ�ടുക്കു�

➢ ഇന്റര്‍നെ�റ്റിനെല IP വിലോസങ്ങനെള ഓര്‍ക്കോന്‍ എളുപ്പമുള്ള പ്രപരു�ളോയി മോറ്റോന്‍ 
സോധ്യമല്ല.

➢ ഇന്റര്‍നെ�റ്റിനെല ഒരു നെവബ്വൈസറ്റിനു ഒരു IP  വിലോസം മോത്രമോണുള്ളത്.

➢ ഇന്റര്‍നെ�റ്റിനെല നെവബ് വിലോസങ്ങനെള ഐ. പി. വിലോസങ്ങളോയി മോറ്റിനെയടുക്കോന്‍ 
സോധ്യമല്ല.

➢ ഇന്റര്‍നെ�റ്റിനെല Xരസ്പരോശ്രി% വിവരജോലികയോ4് www.

17. ചുവനെ� നെ�ോടുത്തിട്ടുള്ളവയില്‍ �വസോമൂuി�മോധ്യമം (www) Social media)ഏത്  ?

➢ വോട്ട് ̂ ്ആപ്പ്

➢ ഗൂഗിള്‍

➢ വിക്കിപീഡിയ

➢ യോഹൂ

18. ചുവനെ� നെ�ോടുത്തിട്ടുള്ള �വസോമൂuി�മോധ്യമങ്ങളില്‍ സ്വതന്ത്ര വിവരവി�ിമയ 
സപ്രhതം ഏത്  ?

➢ വോ�് സ്ആപ്പ്

➢ പ്രഫസ് ബുക്ക്

➢ റ്റ്വിറ്റര്‍

➢ ഡയോ^് നെXോറ

19. ഇന്റര്‍നെ�റ്റ് ചപ്രോചട്ടോചകോളുകളുനെട �വീകര4ങ്ങള്‍ Xരിചjോധിച്ച് അംഗീകരിക്കുന്ന 

^ംഘട� ഏ%് ?
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➢ The Internet Society (ISOC)

➢ The Internet Engineering Task Force (IETF)

➢ The Internet Corporation for Assigned Names and Numbers 
(ICANN)

➢ World Wide Web (WWW)
20. ഇന്റര്‍നെ�റ്റുWോയി 3ന്ധനെപ്പട്ട jരിയോയ പ്ര^്  %ോവ� ചുവനെട �ല്‍കിയവയില്‍ �ിന്നും 

%ിരനെtടുക്കുക

➢ ഇന്റര്‍നെ�റ്റിനെന്റ ഘ��യുപ്ര�യും �യങ്ങളുപ്ര�യും  നെപോതുവിഷയങ്ങളുപ്ര�യും പ്രമല്‍പ്ര�ോ�ം 

വuിക്കുന്ന സംഘ��യോണ്  WWW

➢ ഇന്റര്‍നെ�റ്റിനെന്റ ഘ��യുപ്ര�യും �യങ്ങളുപ്ര�യും നെപോതുവിഷയങ്ങളുപ്ര�യും പ്രമല്‍പ്ര�ോ�ം 

വuിക്കുന്ന സംഘ��യോണ്  IETF

➢ ഇന്റര്‍നെ�റ്റിനെന്റ ഘട�യുചടയും �യങ്ങളുചടയും നെXോതുവിഷയങ്ങളുചടയും ചWല്‍ച�ോട്ടം 

വഹിക്കുന്ന ^ംഘട�യോ4് The Internet Society

➢ ഇന്റര്‍നെ�റ്റിനെന്റ ഘ��യുപ്ര�യും �യങ്ങളുപ്ര�യും  തുവിഷയങ്ങളുപ്ര�യും പ്രമല്‍പ്ര�ോ�ം 

വuിക്കുന്ന സംഘ��യോണ്  ICANN
 

SHORT ANSWER TYPE QUESTIONS

21. �രിയോയ �സ്തോവ��ള്‍ ചുവനെ� �ല്‍�ിയവയില്‍ �ിന്ന് തിരനെ�ടുക്കു�.

➢ %യോറോക്കിയ ര*�കള്‍ ^ൗജ�്യWോയി ഇന്റര്‍നെ�റ്റില്‍ പ്ര^ിദ്ധീകരിക്കോന്‍ 
^ഹോയിക്കുന്ന നെവ3്സൈ^റ്റോ4് www.blogger.com

➢ �ോം �ിര്‍Wിച്ച *ലച്ചിത്രങ്ങള്‍ ഇന്റര്‍നെ�റ്റില്‍ Xങ്കുനെവക്കോന്‍ ^ഹോയിക്കുന്ന 
നെവ3്സൈ^റ്റോ4്  www.vimeo.com.

➢ www.vimeo.com  എന്നത് ഒരു ഇ-ഗപ്രവണന്‍സ് നെവബ്വൈസറ്റോണ്. 

➢ സൗജ�്യമോയി ഇ-നെമയില്‍ പ്രസവ�ം �ല്കുന്ന ഒരു സംരംഭമോണ്  www.vimeo.com.

➢ www. blogger.com  എന്നത് ഒരു ഇ-ഗപ്രവണന്‍സ് നെവബ്വൈസറ്റോണ്. 
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22. �ോം തയോറോക്കിയ രച��ള്‍ സൗജ�്യമോയി ഇന്റര്‍നെ�റ്റില്‍ �സിദ്ധീ�രിക്കോന്‍ 
സuോയിക്കുന്ന നെവബ്വൈസറ്റു�ള്‍ ചുവനെ� നെ�ോടുത്തിരിക്കുന്നവയില്‍ ഏനെതല്ലോം ?  

➢ www.vimeo.com

➢ www.wikimapia.org

➢ www.wordpress.com

➢ www.blogger.com

➢ www.yahoo.com  

23.. �ോം �ിര്‍മിച്ച ചലച്ചിത്രങ്ങള്‍ സൗജ�്യമോയി ഇന്റര്‍നെ�റ്റില്‍ �സിദ്ധീ�രിക്കോന്‍ 
സuോയിക്കുന്ന നെവബ്വൈസറ്റു�ള്‍ ചുവനെ� നെ�ോടുത്തിരിക്കുന്നവയില്‍ ഏനെതല്ലോം ?  

➢ www.vimeo.com

➢ www.wikimapia.org

➢ www.youtube.com

➢ www.gmailcom

➢ www.yahoo.com

24. ചുവനെ� നെ�ോടുത്തിട്ടുള്ളവയില്‍ �വസോമൂuി�മോധ്യമങ്ങള്‍ (www) Social media)ഏനെതല്ലോം ?

➢ വോട്ട്̂ ്ആപ്പ്

➢ ഗൂഗിള്‍

➢ വിക്കിപീഡിയ

➢ യോഹൂ

➢ ച�^്ബുക്ക്

25. നെവബ്വൈസറ്റു�നെളക്കുറിച്ചുള്ള ചില �സ്തോവ��ളോണ് ചുവനെ� �ല്‍�ിയിരിക്കുന്നത്. 
ഇതുമോയി ബന്ധനെപ്പ�് jരിയല്ലോത്തവ �നെണ്ടത്തു�.  

➢ www.blogger.com  എന്ന%് ഒരു ഇ-ഗചവ4ന്‍^് നെവ3്സൈ^റ്റോ4്. 
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➢ സൗജ�്യമോയി ഇ-നെമയില്‍ പ്രസവ�ം �ല്കുന്ന ഒരു സംരംഭമോണ് www.gmail.com .

➢ www.hscap.kerala.gov.in എന്നത് uയര്‍ നെസക്കന്‍ഡറി �പ്രവ��ത്തിനുള്ള 
നെവബ്വൈസറ്റോണ്.  

➢ ഇന്റര്‍നെ�റ്റില്‍ �വര്‍ത്തിക്കുന്ന ഒരു തിരച്ചില്‍ സംവിധോ�മോണ് www.google.com.  

➢ www.en.wiktionary.org എന്ന%് Wലയോളം വിക്കിXീഡിയയുനെട വിലോ^Wോ4്.

26. ഇന്റര്‍നെ�റ്റുമോയി ബന്ധനെപ്പ� ചില �സ്തോവ��ളോണ് ചുവനെ� �ല്‍�ിയിരിക്കുന്നത്. 
ഇതില്‍ �ിന്നും �രിയോയ �സ്തോവ��ള്‍ �നെണ്ടത്തു�.  

➢ �യലുകള്‍ ഒരു കമ്പ്യൂട്ടറില്‍ �ിന്ന് Wനെറ്റോന്നിചലക്ക് സൈകWോറോന്‍ ^ോധിക്കും

➢ ദൂനെരയുള്ള ആളുകളുWോയി കണ്ടു^ം^ോരിക്കോം .

➢ ദൂനെരയുള്ള ആളു�ളുമോയി �ണ്ടുസംസോരിക്കോന്‍ സോധ്യമല്ല.  

➢ ഫയലു�ള്‍ ഒരു �മ്പ്യൂ�റില്‍ �ിന്ന് മനെറ്റോന്നിപ്രലക്ക് വൈ�മോറോന്‍ സോധിക്കില്ല.  

➢ വിവരങ്ങള്‍ എളുപ്പത്തില്‍ പങ്കുവയ്ക്കോന്‍ സോധ്യമല്ല..

27. നെവബ്വൈസറ്റു�ളുമോയി ബന്ധനെപ്പ� ചില �സ്തോവ��ളോണ് ചുവനെ� �ല്‍�ിയിരിക്കുന്നത്.
ഇതില്‍ �ിന്നും �രിയോയ �സ്തോവ��ള്‍ �നെണ്ടത്തു�.

➢ നെ^ര്‍വര്‍ കമ്പ്യൂട്ടറുകളിലോ4് നെവ3്സൈ^റ്റുകള്‍ സ്ഥോXിക്കുന്ന%്.  

➢ നെവബ്വൈസറ്റു�ള്‍ സ്ഥോപിക്കുന്നതി�് എല്ലോ രോജ്യങ്ങളിലും നെസര്‍വറു�ള്‍ പ്രവണം.  

➢ ഒരു നെ^ര്‍വറില്‍ %നെന്ന ഒന്നിലധികം നെവ3്സൈ^റ്റുകള്‍ സ്ഥോXിക്കോം 

➢ ഒരു നെസര്‍വറില്‍ ഒരു നെവബ്വൈസറ്റ് മോത്രപ്രമ സ്ഥോപിക്കോന്‍ സോധിക്കു�യുള്ളൂ.

➢ നെസര്‍വര്‍ �മ്പ്യൂ�റു�ള്‍ക്ക് ഒന്നിലധി�ം IP വിലോസങ്ങള്‍ �ല്‍�ോന്‍ സോധ്യമല്ല.

28. തോനെഴ നെ�ോടുത്തിരിക്കുന്ന �സ്തോവ��ളില്‍ �ിന്നും �രിയോയ �സ്തോവ��ള്‍ 
�നെണ്ടത്തു�.

➢ നെ�റ്റ് വര്‍ക്ക് വഴി കത്തുകള്‍ സൈകWോറുന്ന ^ംവിധോ�Wോ4് ഈനെWയില്‍
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➢ പ്രപോപ്രസ്റ്റോഫീസ് വഴി �ത്തു�ള്‍ വൈ�മോറുന്ന സംവിധോ�മോണ് ഈനെമയില്‍

➢ Gmail ഒരു ഈനെWയില്‍ ^ംവിധോ�Wോ4്.

➢ Vimeo ഒരു ഈനെമയില്‍ സംവിധോ�മോണ്.

➢ Piccasa.ഒരു ഈനെമയില്‍ സംവിധോ�മോണ്.

29. ഇ-ബോhിങ് പ്രസവ�ങ്ങനെള കൂടുതല്‍ സുരക്ഷിതമോക്കോന്‍ ഉപപ്രയോഗിക്കുന്ന 
സംവിധോ�ങ്ങള്‍ ചുവനെ� നെ�ോടുത്തിട്ടുള്ളവയില്‍ ഏനെതോനെക്കയോണ് ?

➢ User name & Password

➢ Bank passbook

➢ Internet

➢ Online Testing Password

➢ One Time Password

30. �വ മോധ്യമങ്ങളുമോയി ബന്ധനെപ്പ� ചില �സ്തോവ��ളോണ് ചുവനെ� 
�ല്‍�ിയിരിക്കുന്നത് ഇതില്‍ �ിന്നും �രിയോയ �സ്തോവ��ള്‍ �നെണ്ടത്തു�

➢ ഒരിക്കല്‍ പ്രപോസ്റ്റ് നെചയ്ത �ോര്യങ്ങള്‍ എപ്രപ്പോള്‍ പ്രവണനെമhിലും തിരിനെച്ചടുക്കോം  

➢ അശ്ലീല ^ച�jങ്ങളും ഭീഷ4ികളും �ിയWXരWോയ കുറ്റകൃ%്യങ്ങളോ4്.

➢ അശ്ലീല സപ്ര¸�ങ്ങളും ഭീഷണി�ളും �ിയമപരമോയ കുറ്റകൃത്യങ്ങളല്ല.

➢ വ്യക്തിXരWോയ വിവരങ്ങള്‍ ^്വകോര്യWോയി %നെന്ന സൂക്ഷിക്ക4ം

➢ വ്യക്തിപരമോയ വിവരങ്ങള്‍ സ്വ�ോര്യമോയി സൂക്ഷിക്കുന്നത് �ല്ലതല്ല.

31.. ചുവനെ� നെ�ോടുത്തിട്ടുള്ളവയില്‍ �വസോമൂuി�മോധ്യമങ്ങള്‍ (www) Social media)
അല്ലോത്ത%് ഏനെതല്ലോം ?

➢ വോ�്സ് ആപ്പ്

➢ പ്രഫസ്  ബുക്ക്
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➢ വിക്കിXീഡിയ

➢ റ്റ്വിറ്റര്‍

➢ സ്കൂള്‍വിക്കി

32. ഇ-3ോങ്കിങ് ച^വ�വുWോയി 3ന്ധനെപ്പട്ട പ്രസ്തോവ�കളില്‍ jരിയല്ലോത്തവ ഏനെ%ല്ലോWോ4്

➢ ഇതി�് യൂസര്‍നെ�യിം, പോസ് പ്രവഡ് എന്നിവ ആവ�്യമോണ്.  

➢ അക്കൗണ്ട് ഉടWയ്ക്ക് ^്വന്തWോയി നെവ3്സൈ^റ്റ് ഉണ്ടോയിരിക്ക4ം.  

➢ മനെറ്റോരു അക്കൗണ്ടിപ്രലക്ക് പണം വ� മോറ്റോം. 

➢ അക്കൗണ്ട് സംബന്ധിച്ച വിവരങ്ങള്‍ ബോhില്‍ പ്രപോ�ോനെത തനെന്ന പരിപ്ര�ോധിക്കോം.

➢ മുന്‍X് �ടത്തിയ ഇടXോടുകള്‍ Xരിചjോധിക്കോന്‍ ^ോധ്യWല്ല.
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STANDARD X INFORMATION COMMUNICATION TECHNOLOGY 

 അധ്യായം 8 –    ഡാറ്റാബേ
സ്  ഒരു ആമുഖം ഒരു ആമുഖം ആമുഖം 

  തിയറി ബേ�ാദ്യങ്ങളും ഉത്തരങ്ങളും 

1)  ലിബര്‍ഓഫീസ്  ബേബസില്‍ തയാറാക്കിയ ,  വിദ്യാര്‍ത്ഥികളുടെ� ഡാറ്റാബേബസില്‍ പ്രൈ�മറി  കീ  ആയി  നിര്‍

വചിക്കാവുന്നത് ചുവടെ� തന്നിരിക്കുന്നവയില്‍ ഏത് ?

➢ Date of Birth

➢ Age

➢ Date of Admission

➢ Admission No

2. ലിബര്‍ഓഫീസ് ബേബസിടെല ഒരു പട്ടികയില്‍ (Table) Table) നല്‍കിയിട്ടുള്ള വിവരങ്ങളില്‍ നിന്ന് നിബന്ധനകള്‍

ക്കനുസരിച്ചള്ള വിവരങ്ങള്‍ മാത്രം ലഭ്യമാക്കുന്നതിന് ഉപബേയാഗിക്കുന്ന ഒരു സബേ9തം എത്?

➢ ക്വറീസ് (Queries)Queries)

➢ ബേഫാംസ് (Table) Forms)

➢ ഫീല്‍ഡ്സ് (Table) Fields)

➢ കാറ്റഗറീസ് (Table) Categories)

3. ലിബര്‍ഓഫീസ് ബേബസിടെല  ബേഫാമിന് (Table) Forms) വ്യത്യസ്ത ബേലഔട്ടുകള്‍ നല്കുന്നതിനായി തിരടെ>ടുക്കാവുന്നത് 

ഏത്?

➢ Field Type

➢ Arrange Controls

➢ Set up a subform

➢ Apply Styles 

4. ലിബര്‍ഓഫീസ്  ബേബസിടെല ക്വറി  (Table) Query)  നിര്‍മാണവുമായി  ബന്ധമില്ലാത്ത �വര്‍ത്തനം  ചുവടെ� 

ടെകാടുത്തിരിക്കുന്നവയില്‍ ഏതാണ് ?

➢ Field Selection

➢ Sorting Order
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➢ Search Conditions

➢ Arrange Controls

5. ലിബര്‍ഓഫീസ് ബേബസില്‍ തയാറാക്കുന്ന ഒരു ഡാറ്റാബേബസില്‍ ഉള്‍ടെDടുത്താവുന്ന പട്ടികകളുടെ� (Table) Table) 

എണ്ണവുമായി ബന്ധടെDട്ട്  ചുവടെ� ടെകാടുത്തിരിക്കുന്നവയില്‍ ശരിയായ �സ്താവന ഏതാണ് ?

➢ ഒരു പട്ടിക മാത്രബേമ ഉള്‍ടെDടുത്താന്‍ കഴിയൂ

➢ രണ്ട് പട്ടികകള്‍ വടെര ഉള്‍ടെDടുത്താം

➢ പരമാവധി മൂന്ന് പട്ടികകള്‍ ഉള്‍ടെDടുത്താം

➢ എത്ര പട്ടികകള്‍ വേ�ണമെ�ങ്കിലും ഉള്‍മെ�ടുത്താം

6. ഒരു പരീക്ഷയില്‍ പടെ9ടുക്കുന്ന കുട്ടികളുടെ� ഡാറ്റാബേബസില്‍ രജിസ്റ്റര്‍ നമ്പര്‍ പ്രൈ�മറി കീ ആയി ടെസറ്റ് 

ടെചയ് താലുള്ള സൗകര്യം ചുവ ടെ� ടെകാടുത്തിരിക്കുന്നവയില്‍ ഏതാണ് ?

➢ ഒന്നിലധികം കുട്ടികള്‍ക്ക് ഒബേര രജിസ്റ്റര്‍ നമ്പര്‍ നല്‍കാം.

➢ എല്ലാം കുട്ടികള്‍ക്കും �്യത്യസ്ത രജിസ്റ്റര്‍ നമ്പരുകള്‍ നല്‍കാം

➢ രണ്ട് കുട്ടികള്‍ക്ക് മാത്രം ഒബേര രജിസ്റ്റര്‍ നമ്പര്‍ നല്‍കാം

➢ എല്ലാം കുട്ടികള്‍ക്കും ഒബേര രജിസ്റ്റര്‍ നമ്പര്‍ നല്‍കാം

7. ചുവടെ� തന്നിരിക്കുന്നവയില്‍ ഒരു ഡാറ്റാബേബസുമായി ബേനരിട്ട് സംവദിക്കാന്‍ ഉപബേയാഗിക്കുന്ന  ക്വറി ഭാഷ 

(Table) Query Languages) ഏതാണ് ?

➢ JAVA

➢ PYTHON

➢ SQL

➢ CPP

8. ഒരു ഡാറ്റാബേബസ് പട്ടികയില്‍ നിന്നും എത്ര ക്വറികള്‍ (Table) Queries) നിര്‍മിക്കുവാന്‍ സാധിക്കും?

➢ എത്ര എണ്ണം വേ�ണമെ�ങ്കിലും

➢ ഒടെരണ്ണം മാത്രം

➢ രടെണ്ടണ്ണം മാത്രം

➢ പരമാവധി മൂടെന്നണ്ണം
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9. ചുവടെ� ടെകാടുത്തിരിക്കുന്നവയില്‍, ലിബര്‍ഓഫീസ് ബേബസില്‍ ബേഫാം (Table) Forms) നിര്‍മിക്കുന്നതുമായി 
ബന്ധമില്ലാത്ത �വര്‍ത്തനം ഏത് ?

➢ Field Selection

➢ Field Type

➢ Arrange Controls

➢ Apply Styles

10. ഒരു ഡാറ്റാബേബസിടെന സംബന്ധിച്ച് താടെഴ പറയുന്നവയില്‍  ശരിയല്ലാത്ത �സ്താവന ഏത്?

➢ വിവരങ്ങള്‍ അടുക്കും ചിട്ടബേയാടെ� ബേശഖരിച്ച് ടെവക്കാം

➢ ആവശ്യാനുസരണം പട്ടികകളുള്‍ടെDടുത്താം

➢ വിവരങ്ങള്‍ ആവശ്യാനുസരണം കൂട്ടിബേച്ചര്‍ക്കാം

➢ വേ,ര്‍ത്ത �ി�രങ്ങളില്‍ �ാറ്റം �രുത്തുക സാധ്യ�ല്ല

11. ബര്‍ഓഫീസ് ബേബസില്‍ നിര്‍മിച്ച ഒരു പട്ടികയുടെ� ഒരു ബേകാളത്തിലുള്ള വിവരങ്ങള്‍ ഏതുതരത്തിലുള്ളതാടെണന്ന് 

നിശ്ചയിക്കുന്നത് ചുവടെ� ടെകാടുത്തിരിക്കുന്നവയില്‍ ഏതാണ്?

➢ ഫീല്‍ഡ് ടെനയിം

➢ ഫീല്‍ഡ് ടൈ5�്

➢ പ്രൈ�മറി കീ

➢ റിബേക്കാര്‍ഡ്

12.ചുവടെ� നല്‍കിയവയില്‍ ഏതാണ്  ലിബര്‍ഓഫീസ് ബേബസില്‍  ലഭ്യ�ല്ലാത്ത സബേ9തം ഏത് ? 

➢ Tables

➢ Queries

➢ Reports

➢ Styles

13. ലിബര്‍ഓഫീസ് ബേബസില്‍ ഒരു ബേഫാം (Table) Form) ഉള്‍ടെDടുത്തുന്നതു ടെകാണ്ട് ഏതു �വര്‍ത്തനമാണ് 

സാധ്യമാകുന്നത് ?

➢ വിവരങ്ങള്‍ ബേചര്‍ക്കാം

➢ പ്രൈ�മറി കീ ടെസറ്റ് ടെചയ്യാം
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➢ റിബേDാര്‍ട്ടുകള്‍ നിര്‍മിക്കാം

➢ നിശ്ചിത വിവരങ്ങള്‍ മാത്രം ലഭ്യമാക്കാം

14. ഒരു ഡാറ്റാബേബസിടെല പട്ടികയിബേലക്ക് (Table) Table) വിവരങ്ങള്‍ ബേചര്‍ക്കുന്നതിന് ഉപബേയാഗിക്കാവുന്ന 

ഡാറ്റാബേബസിടെല സബേ9തം ഏതാണ് ?

➢ ഫീല്‍ഡുകള്‍ (Table) Fields)

➢ റിബേDാര്‍ട്ടുകള്‍ (Table) Reports)

➢ വേഫാമുകള്‍ (Queries)Forms)

➢ ഡാറ്റാ പ്രൈ�പ്പുകള്‍ (Table) Data Types)

15. ഒരു ഡാറ്റാബേബസ് മാബേനജ്ടെമന്റ് സിസ്റ്റം (Table) DBMS) ഉപബേയാഗിച്ച് ടെചയ്യാന്‍ കഴിയാത്ത �വര്‍ത്തനം ചുവടെ� 

ടെകാടുത്തിരിക്കുന്നവയില്‍ ഏതാണ് ?

➢ ഡാറ്റാബേബസിബേലക്ക് പുതിയ ഡാറ്റ കൂട്ടിബേച്ചര്‍ക്കല്‍

➢ ഡാറ്റാബേബസിടെല ആവശ്യമില്ലാത്ത ഡാറ്റ നീക്കം ടെചയ്യല്‍

➢ ഡാറ്റാബേബസിബേലക്ക് ചിത്രങ്ങളും വീഡിബേയാകളും ബേചര്‍ക്കല്‍

➢ ,ിത്രങ്ങളും �ീഡിവേയാകളും എഡിറ്റ് മെ,യ്യല്‍

16. ഒരു ഡാറ്റാബേബസിടെല പട്ടികയില്‍ (Table) Table) നിര്‍വചിച്ചിട്ടുള്ള ഫീല്‍ഡുകളുടെ� എണ്ണവും പട്ടികയിടെല 

ബേകാളങ്ങളുടെ� (Table) Column) എണ്ണവും  തമ്മിലുള്ള ബന്ധം എന്ത് ?

➢ തുല്യ�ായിരിക്കും

➢ ഒന്ന് കൂടുതലായിരിക്കും

➢ ഒന്ന് കുറവായിരിക്കും

➢ വ്യത്യസ് തമായിരിക്കും

17. ചുവടെ� ടെകാടുത്തിരിക്കുന്ന ബേജാ�ികളില്‍ ലിബര്‍ഓഫീസ് ബേബസിടെന സംബന്ധിച്ച് ശരിയല്ലാത്തത് ഏത് ?

Employee_ID           - Number [NUMERIC]

Employee_Designation - Text [VARCHAR]

Date_of_Birth           - Image [LONGVARBINARY]

Basic_ Salary            - Decimal [DECIMAL]
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18. ലിബര്‍ഓഫീസ് ബേബസില്‍ ചിത്രങ്ങള്‍ ഉള്‍ടെDടുത്തുന്നതിനുള്ള ഫീല്‍ഡ് നിര്‍വചിബേക്കണ്ടത് താടെഴ 

ടെകാടുത്തിരിക്കുന്നവയില്‍ ഏതു രീതിയിലാണ് ?

➢ Text (Table) fix) [CHAR]

➢ Text[VARCHAR]

➢ Image [LONGVARBINARY]

➢ Integer [INTEGER]

19. ബര്‍ഓഫീസ് ഡാറ്റാബേബസില്‍ Image [LONGVARBINARY] എന്ന ഫീല്‍ഡ് പ്രൈ�D് നിശ്ചയിച്ചിട്ടുള്ള 

ബേകാളത്തില്‍ ഉള്‍ടെDടുബേത്തണ്ട ഡാറ്റ ഏത് ?

➢ ,ിത്രം

➢ ചലചിത്രം

➢ ശബ്ദം

➢ ടെ�ക് സ്റ്റ്

20. ചുവടെ� ടെകാടുത്തിരിക്കുന്നവയില്‍ ഏതാണ് ലിബര്‍ഓഫീസ് ബേബസില്‍ ക്വറി (Table) Query) നിര്‍മാണവുമായി 

ബന്ധമില്ലാത്തത് ?

➢ Create Query in Design View

➢ Create Query in Table View

➢ Create Query in SQL View

➢ Use Wizard to Create Query

21. ചുവടെ� ടെകാടുത്തിരിക്കുന്നവയില്‍ ഡാറ്റാബേബസ് മാബേനജ്ടെമന്റ് സിസ്റ്റം 

ബേസാഫ്റ്റ് ടെവയറുകള്‍ ഏവ ?

➢ LibreOffice Writer

➢ MySQL 

➢ Inkscape

➢ LibreOffice Base

➢ Synfig Studio
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22. ലിബര്‍ ഓഫീസ് ഡാറ്റാബേബസില്‍ പട്ടിക (Table) Table) നിര്‍മ്മിക്കുന്നതിനായി Create Table in 

DesignView തിരടെ>ടുത്താല്‍ ഏടെതാടെക്ക കാര്യങ്ങളാണ് നിര്‍വ്വചിക്കാനാവുക?

➢ Field Record

➢ Field Name

➢ Record Name

➢ Field Type

➢ Record Type

23) ലിബര്‍ ഓഫീസ് ഡാറ്റാബേബസില്‍ പ്രൈ�മറി കീയുമായി ബന്ധടെDട്ട് ചുവടെ� 

ടെകാടുത്തിരിക്കുന്നവയില്‍ ശരിയായ രണ്ട് �സ്താവനകള്‍ ഏവ?

➢ ടൈ<�റി കീയുമെ5 �ില എവേ�ാഴും അനന്യം (unique) unique) ആയിരിക്കും.

➢ എല്ലാ ഫീല്‍ഡുകളും പ്രൈ�മറി കീകളായി നിര്‍വചിച്ചിരിക്കണം.

➢ ഒരു പട്ടികയില്‍ ചുരുങ്ങിയത് രണ്ട് പ്രൈ�മറി കീടെയ9ിലും ഉണ്ടായിരിക്കണം

➢ ഒരു പട്ടികയില്‍ നിര്‍വ്വചിക്കാവുന്ന പരമാവധി പ്രൈ�മറി കീകളുടെ� എണ്ണം മൂന്നാണ്.

➢        പ്രൈ�മറി കീയെ അടിസ്ഥാനമാക്കിയാണ് ഡാറ്റാബേസ് ഓരോ റിക്കോര്‍ഡും തിരിച്ചറിയുന്നത്യ അടിസ്ഥാനമാക്കിയാണ്  ഒരു ആമുഖം ഡാറ്റാബേ
സ്  ഒരു ആമുഖം ഓബേരാ റിബേക്കാര്  ഒരു ആമുഖംഡും തിരിച്ചറിയുന്നത്  ഒരു ആമുഖം.

24) ലിബര്‍ഓഫീസ് ബേബസില്‍ Query ഉപബേയാഗിക്കുന്നത് തന്നിരിക്കുന്നവയില്‍ എടെന്തല്ലാം ആവശ്യങ്ങള്‍

ക്കാണ് ?

➢ പട്ടികയിബേലക്ക് വിവരങ്ങള്‍ ഉള്‍ടെDടുത്തുന്നതിന്.

➢ പട്ടികയിമെല ആ�ശ്യ�ായ �ി�രങ്ങള്‍  �ാത്രം ലഭ്യ�ാക്കുന്നതിന്.

➢ പട്ടികയിടെല വിവരങ്ങള്‍ ഏതു തരത്തിലുള്ളവയാടെണന്ന് കടെണ്ടത്തുന്നതിന്.

➢ പട്ടികയിമെല �ി�രങ്ങള്‍ ഉള്‍മെ�ടുത്തി മെ,റുപട്ടികകള്‍ രൂപീകരിക്കുന്നതിന്

➢ പട്ടികയില്‍ ബേചര്‍ത്ത വിവരങ്ങള്‍ക്ക് മാറ്റം വരുത്തുന്നതിന്.

25) ചുവടെ� ടെകാടുത്തിരിക്കുന്നവയില്‍ നിന്നും ഡാറ്റാബേബസ് മാബേനജ്ടെമന്റ് സിസ്റ്റത്തിടെന്റ (Table) DBMS) രണ്ട് 
ഉപബേയാഗങ്ങള്‍ കടെണ്ടത്തുക

➢ DBMS ഉപബേയാഗിച്ച് ഇ-ടെമയില്‍ അയക്കാം.

➢ DBMS ഉപവേയാഗിച്ച് ഡാറ്റാ അപഗ്രഥനം ന5ത്താം.
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➢ DBMS ഉപവേയാഗിച്ച് ആ�ശ്യ�ില്ലാത്ത ഡാറ്റ നീക്കം മെ,യ്യാം

➢ DBMS ഉപബേയാഗിച്ച് ഡാറ്റാബേബസിലുള്‍ടെDട്ട വീഡിബേയാ എഡിറ്റ് ടെചയ്യാം.

➢ DBMS ഉപബേയാഗിച്ച് ഡാറ്റാബേബസിലുള്‍ടെDട്ട ഓഡിബേയാ എഡിറ്റ് ടെചയ്യാം.

26) ലിബര്‍ഓഫീസ് ബേബസില്‍ ബേഫാം നിര്‍മിക്കുന്ന �വര്‍ത്തനത്തിടെന്റ രണ്ട് സൂചനകള്‍
 ചുവടെ� നല്‍കിയവയില്‍ നിന്ന് കടെണ്ടത്തുക.

➢ Use Wizard to Create Form തുറക്കുക.

➢ Use Wizard to Create Report തുറക്കുക.

➢ ആവശ്യമുള്ള വിവരങ്ങള്‍ ലഭിക്കുന്നതിനുള്ള ടെസര്‍ച്ച് കണ്ടീഷന്‍ നല്കുി Form നിര്‍മ്മിക്കുക.

➢ തയാറാക്കിയ പട്ടിക Table or queries ല്‍ നിന്നും തിരമെJടുത്ത് Form നിര്‍മ്മിക്കുക.

➢ Create Report ല്‍ നിന്നും അനുബേയാജ്യമായ  Report തിരടെ>ടുത്ത് Form നിര്‍മ്മിക്കുക.

27) ലിബര്‍ഓഫീസ് ബേബസില്‍ ക്വറി (Table) Queries) നിര്‍മിക്കുന്ന �വര്‍ത്തനത്തിടെന്റ രണ്ട് സൂചനകള്‍ ചുവടെ� നല്‍
കിയവയില്‍ നിന്ന് കടെണ്ടത്തുക.

➢ Use Wizard to Create Form തുറക്കുക.

➢ Use Wizard to Create Query തുറക്കുക.

➢ ആ�ശ്യമുള്ള �ി�രങ്ങള്‍ ലഭിക്കുന്നതിനുള്ള മെസര്‍ച്ച് കണ്ടീഷന്‍ നല്കുക.

➢ Arrange controls എന്നതില്‍ നിന്നും അനുബേയാജ്യമായ Arrangement തിരടെ>ടുക്കുക

➢ Title Report ല്‍ ബേപര് നല്കി Finish Button ക്ലിക്ക് ടെചയ്യുക

28)  ലിബര്‍ഓഫീസ് ബേബസില്‍ റിബേDാര്‍ട്ട് (Table) Report) നിര്‍മിക്കുന്ന �വര്‍ത്തനത്തിടെന്റ രണ്ട് ചുവടെ� നല്‍കിയവയില്‍ 
നിന്ന് കടെണ്ടത്തുക

➢ ആവശ്യമുള്ള വിവരങ്ങള്‍ ലഭിക്കുന്നതിനുള്ള ടെസര്‍ച്ച് കണ്ടീഷന്‍ നല്കുക.

➢ Title Report ല്‍ ബേപര് നല്കി Finish Button ക്ലിക്ക് ടെചയ്യുക

➢ Use Wizard to Create Report തുറക്കുക.

➢ Arrange controls എന്നതില്‍ നിന്നും അനുബേയാജ്യമായ  Arrangement  തിരടെ>ടുത്ത് റിബേDാര്‍ട്ട് തയാറാക്കുക.

➢ അനുവേയാജ്യ�ായ വേലഔട്ട് തിരമെJടുത്ത് റിവേ�ാര്‍ട്ട് തയാറാക്കുക.

29) ഒരു ഡാറ്റാബേബസ് മാബേനജ്ടെമന്റ് സിസ്റ്റടെത്ത സംബന്ധിച്ച് ഏറ്റവും അനുബേയാജ്യമായ രണ്ട് �സ്താവനകള്‍ 

http://www.shenischool.in/
https://t.me/Shenibloggroup


ഏവ ?

➢ ഓഡിബേയാ എഡിറ്റ് ടെചയ്യാം.

➢ സുരക്ഷിത�ായി ഡാറ്റ ടൈകകാര്യം മെ,യ്യുന്നതിന് ഉപവേയാഗിക്കാം

➢ അപ്ലിവേക്കഷന്‍ വേസാഫ്റ്റ് മെ�യര്‍, ഡാറ്റാവേXസ് ഇ�യ്ക്കി5യിലുള്ള കണ്ണിയായി <�ര്‍ത്തിക്കാം.

➢ വീഡിബേയാ എഡിറ്റ് ടെചയ്യാം.

➢ ഇന്റര്‍ടെനറ്റിടെന്റ ഡാറ്റാസ്പീഡ് വര്‍ദ്ധിDിക്കാം.

30)  ഒരു ഡാറ്റബേബസിടെന്റ മാതൃകയാണ് ചിത്രത്തില്‍ നല്കിയിരിക്കുന്നത്.

ചിത്രം വിശകലനം ടെചയ്ത് ചുവടെ� നല്കിയ �സ്താവനകളില്‍ ശരിയായ രടെണ്ടണ്ണം തിരടെ>ടുക്കുക.

➢ ചു�ന്ന ,തുരത്തില്‍ അ5യാളമെ�ടുത്തിയത്  ഒരു റിവേക്കാര്‍ഡിമെന സൂ,ി�ിക്കുന്നു

➢ ചുവന്ന ചതുരത്തില്‍ അ�യാളടെDടുത്തിയത് ഒരു ഫീല്‍ഡിടെന സൂചിDിക്കുന്നു

➢ നീല ദീര്‍ഘവൃത്തത്തില്‍ അ�യാളടെDടുത്തിയത് ഒരു റിബേക്കാര്‍ഡിടെന സൂചിDിക്കുന്നു

➢ നീല ദീര്‍ഘവൃത്തത്തില്‍ അ5യാളമെ�ടുത്തിയത് ഒരു ഫീല്‍ഡിമെന സൂ,ി�ിക്കുന്നു

➢ നീല ദീര്‍ഘവൃത്തത്തില്‍ അ�യാളടെDടുത്തിയത് പ്രൈ�മറി കീടെയ സൂചിDിക്കുന്നു
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   പത്താം ക്ലാസ്  ഐ ക്ലാസ്  ഐ ഐ.സി.ടി
അധ്യായം ക്ലാസ്  ഐ 9:ചലിക്കും ക്ലാസ്  ഐ ചിത്രങ്ങള്‍

ചചാച�്യാത്തരങ്ങള്‍

1) ചുവടെട തന്നിരിക്കുന്നവയില്‍ അനിച ഷന്‍ നിര്‍മ്മാണത്തിന്  ഐ ഉപചയാഗിക്കാവുന്ന  

സ്വതന്ത്ര ചസാഫ്റ്റ്  ഐ ടെവയര്‍ ഏത്  ഐ?

a) Tupi: Open 2D magic

b) Anime studio

c) Sunclock

d) Inkscape

2) Synfig Studio യിടെല  ടൂള്‍ച/ാക്സിലുള്ള ഈ സൂചനാചിത്രം ക്ലാസ്  ഐ ഏത്  ഐ ടൂളിടെന സൂചിപ്പിക്കുന്നു ?

a) Layers Panel

b) Time Track Panel

c) Parameters Panel

d) Canvas

3) Synfig Studio ചസാഫ്റ്റ്  ഐ ടെവയറിടെ9 തനതു ഫയല്‍ചഫാര്‍ ാറ്റ്  ഐ ഏത്  ഐ?   

a) svg

b) flv

c) sifz

d) xcf

4) Inkscape ല്‍ തയാറാക്കിയ svg ചിത്രം ക്ലാസ്  ഐ Synfig Studio ചസാഫ്റ്റ്  ഐ ടെവയറിചലക്ക്  ഐ  ഉള്‍

ടെപ്പടുത്താന്‍ ചുവടെട നല്‍കിയിരിക്കുന്ന ഏത്  ഐ സച?തം ക്ലാസ്  ഐ ഉപചയാഗിക്കാം ക്ലാസ്  ഐ?

a) ഇന്‍ചസര്‍ട്ട്  ഐ

b) ഓപ്പണ്‍

c) ഇംപ�ോര്‍ട്ട്
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d) ടെറന്‍ഡര്‍

5) Synfig Studio യില്‍ തയാറാക്കുന്ന ഒരു അനിച ഷടെന, flv ഫയലാക്കി  ാറ്റാന്‍ ചുവടെട

നല്‍കിയവയില്‍ ഏത്  ഐ സച?ത ാണ്  ഐ ഉപചയാഗിചക്കണ്ടത്  ഐ?

a) Save

b) Revert

c) Import 

d) Render 

6) സിന്‍ഫിഗ്  ഐ സ്റ്റുഡിചയായില്‍ രണ്ട്  ഐ നിറങ്ങള്‍ ലയിച്ചുള്ള പശ്ചാത്തലം ക്ലാസ്  ഐ നല്‍കാന്‍ ഏറ്റവും ക്ലാസ്  ഐ 

അനുചയാജ്യ ായ ടൂള്‍ ഏതാണ്  ഐ.

a) Gradient Tool

b) Fill Tool

c) Scale Tool

d) Rectangle Tool

7) Synfig Studio യില്‍നിന്ന്  ഐ എക്സ്  ഐ ചപാര്‍ട്ട്  ഐ ടെചയ്യാന്‍ സാധിക്കുന്ന വീഡിചയാ ഫയല്‍

ചഫാര്‍ ാറ്റ്  ഐ ചുവടെട നല്‍കിയവയില്‍ ഏത്  ഐ?

a) Gif

b) png

c) mpeg

d) xcf

8) ചുവടെട തന്നിരിക്കുന്നവയില്‍ �്വി ാന അനിച ഷന്‍ തയാറാക്കുന്നതിന്  ഐ  

ഉപചയാഗിക്കാവുന്ന  സ്വതന്ത്ര ചസാഫ്റ്റ്  ഐ ടെവയര്‍ ഏത്  ഐ?

a) Adobe flash

b) Synfig Studio

c) ToonBoom

d)  Blender

9)  Synfig Studio യിടെല ചില ടൂളുകളും ക്ലാസ്  ഐ അവയുടെട വിവരണങ്ങളും ക്ലാസ്  ഐ ആണ്  ഐ  പട്ടികയില്‍ 

നല്‍കിയിരിക്കുന്നത്  ഐ.വിട്ട്  ഐചപായ ഭാഗം ക്ലാസ്  ഐ ചുവടെട ടെകാടുത്തിയിരിക്കുന്നതില്‍ നിന്ന്  ഐ 
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കടെണ്ടത്തുക.

a) Fill Tool

b) Transform Tool

c) Scale Tool

d) Rotate Tool

10) png ചഫാര്‍ ാറ്റിലുള്ള ചിത്രങ്ങള്‍SynfigStudio ചസാഫ്  ഐ റ്റ്  ഐ ടെവയറിചലക്ക്  ഐ ഉള്‍ടെപ്പടുത്താന്‍

 ചുവടെട നല്‍കിയിരിക്കുന്ന ഏത്  ഐ  ാര്‍ഗം ക്ലാസ്  ഐ ഉപചയാഗിക്കാം ക്ലാസ്  ഐ?

a) File --> Open

b) File --> Import

c) Insert --> Image

d) Insert --> bitmap 

11) Synfig  Studio  ഉപചയാഗിച്ച്  ഐ  പ്രഭാതസൂര്യടെ9 അനിച ഷന്‍ തയാറാക്കുകയാണ്  ഐ  

വരുണ്‍.  സൂര്യന്  ഐ  അതിടെ9 സഞ്ചാരത്തിനനുസരിച്ച്  ഐ  വ്യത്യസ്ത നിറം ക്ലാസ്  ഐ  നല്‍കുന്നതിന്  ഐ  

ഉപചയാഗിചക്കണ്ട ടൂള്‍ ഏതാണ്  ഐ? 

a) Gradient Tool

b) SmoothMove Tool

c) Fill Tool

d) Rectangle Tool

12) Synfig Studio യില്‍ അനിച ഷന്‍ തയാറാക്കുചgാള്‍, ഒ/്  ഐ ജക്  ഐ ടുകളുടെട സ്ഥാനം ക്ലാസ്  ഐ 

ക്ര ീകരിക്കുന്നതില്‍ ശ്രദ്ധിചക്കണ്ട കാര്യം ക്ലാസ്  ഐ ചുവടെട നല്‍കിയ വയില്‍ ഏതാണ്  ഐ?

a) ചലനം ക്ലാസ്  ഐ ആരം ക്ലാസ്  ഐഭിക്കുന്ന ടെnയി ിലും ക്ലാസ്  ഐ അവസാനിക്കുന്ന ടെnയി ിലും ക്ലാസ്  ഐ  ഒ/്  ഐ ജക്  ഐ ട്  ഐ Hide 

ടെചയ്യുക.  

b) ചലനം ക്ലാസ്  ഐ ആരം ക്ലാസ്  ഐഭിക്കുന്ന  ടെnയി ില്‍ ഒ/്  ഐ ജക്  ഐ ട്  ഐ Hide ടെചയ്യുക.  

c) ചലനം ആരംഭിക്കുന്ന ഫ്രെ�യിമിലും അവസോനിക്കുന്ന ഫ്രെ�യിമിലും ഒബ് ജക് ടിഫ്രെ  സ്ഥോനം 

വ്യത്യോസഫ്രെ$ടുത്തുക.

d) ചലനം ക്ലാസ്  ഐ ആരം ക്ലാസ്  ഐഭിക്കുന്ന ടെnയി ിലും ക്ലാസ്  ഐ അവസാനിക്കുന്ന ടെnയി ിലും ക്ലാസ്  ഐ ഒ/്  ഐ ജക്  ഐ ട്  ഐ ഒചര 
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സ്ഥാനത്ത്  ഐ ക്ര ീകരിക്കുക

13) Synfig Studio യില്‍ പശ്ചാത്തലത്തിന്  ഐ നല്‍കിയ ചpഡിയ9്  ഐ നിറം ക്ലാസ്  ഐ എഡിറ്റ്  ഐ ടെചയ്യാന്‍

എവിടെടയാണ്  ഐ സൗകര്യമുള്ളത്  ഐ? 

a) ടെലചയഴ്  ഐ സ്  ഐ പാനല്‍

b) ടൈടം ക്ലാസ്  ഐട്രാക്ക്  ഐ പാനല്‍

c) �രോമീപ(ഴ് സ് �ോനല്‍

d) കാന്‍വാസ്  ഐ ചപ്രാപര്‍ട്ടീസ്  ഐ

14) Synfig Studio യില്‍ Frames Per Second  ാറ്റുന്നതിന്  ഐ ഏത്  ഐ ജാലകത്തിലാണ്  ഐ 

സൗകര്യമുള്ളത്  ഐ?

a) ടെലചയഴ്  ഐ സ്  ഐ പാനല്‍

b) ടൈടം ക്ലാസ്  ഐട്രാക്ക്  ഐ പാനല്‍

c) പരാ ീചറ്റഴ്  ഐ സ്  ഐ പാനല്‍

d) കോന്‍വോസ് പ,ോ�ര്‍ട്ടീസ്

15) Synfig Studio യില്‍ കീടെnയിമുകള്‍ നിശ്ചയിച്ചാല്‍ അവയ്ക്കിടയിടെല ടെnയിമുകടെള 

ചസാഫ്റ്റ്  ഐ ടെവയര്‍ സ്വയം ക്ലാസ്  ഐ പൂര്‍ത്തിയാക്കുന്ന സച?തത്തിന്  ഐ പറയുന്ന ചപടെരന്ത്  ഐ ?

a) ടെറന്‍ഡറിങ്  ഐ

b) ട്വീനിങ്

c) ഇന്‍ചസര്‍ട്ടിങ്  ഐ

d) എക്സ്  ഐചപാര്‍ട്ടിങ്  ഐ

16) Synfig Studio യില്‍ തയാറാക്കിയ അനിച ഷന്‍ Export ടെചയ്യാവുന്ന ചലച്ചിത്ര    
ചഫാര്‍ ാറ്റ്  ഐ ചുവടെട നല്‍കിയവയില്‍ ഏത്  ഐ ?

a) jpg

b) svg

c) png

https://t.me/Shenibloggroup


d) flv

17)  ചറാ/ര്‍ട്ട്  ഐ  /ി  ക്വാറ്റ്  ഐ ല്‍/ാം ക്ലാസ്  ഐ  നിര്‍മ്മിച്ച ഒരു സ്വതന്ത്രചസാഫ്റ്റ്  ഐ ടെവയര്‍ ചുവടെട നല്‍

കിയിരിക്കുന്നവയില്‍ ഏതാണ ്  ഐ?

a) ക്യൂജിസ്  ഐ

b) സിന്‍ഫിഗ് സ്റ്റുഡിപയോ 

c) ഇ?്  ഐസ്  ഐ ചകപ്  ഐ

d) ജിചയാജിബ്ര

18)  ചലചിത്രങ്ങളു ായി /ന്ധടെപ്പട്ട ഒരു ചുരുക്കചപ്പരാണ്  ഐ FPS.                                   

ഇത്  ഐ എന്തിടെന സൂചിപ്പിക്കുന്നു ?

a) ഒരു  ിനിറ്റില്‍ പ്ര�ര്‍ശിപ്പിക്കുന്ന സീനുകളുടെട എണ്ണം ക്ലാസ്  ഐ.

b) ഒരു ടെസക്ക9ില്‍ പ്ര�ര്‍ശിപ്പിക്കുന്ന കഥാപാത്രങ്ങളുടെട എണ്ണം ക്ലാസ്  ഐ.

c) ഒരു ഫ്രെസക്ക ില്‍ ,ദര്‍ശി$ിക്കുന്ന ഫ്രെ�യിമുകളുഫ്രെട എണ്ണം.

d) ഒരു  ിനിറ്റില്‍ പ്ര�ര്‍ശിപ്പിക്കുന്ന ടെnയിമുകളുടെട എണ്ണം ക്ലാസ്  ഐ.

19) Synfig Studio ചസാഫ്റ്റ്  ഐ ടെവയറില്‍ ആകാശത്തിടെല നക്ഷത്രങ്ങടെള വരയ്ക്കുകയാണ്  ഐ ചരഷ്  ഐ  . 

വരച്ച നക്ഷത്രങ്ങടെള ആകാശത്തിടെ9 വിവിധ ഭാഗങ്ങളില്‍ വിന്യസിക്കുന്നതിനായി 

ഉപചയാഗിചക്കണ്ട ടൂള്‍ ഏതാണ്  ഐ?

a) Gradient Tool

b) Star Tool

c) Transform Tool  

d)  Fill Tool

20)  Synfig Studio ചസാഫ്റ്റ്  ഐ ടെവയറിടെല ഒരു ടൂളിടെ9 ചിത്ര ാണ്  ഐ നല്‍കിയിരിക്കുന്നത്  ഐ  
ഇതിടെ9 ഉപചയാഗടെ ന്ത്  ഐ?

a) ചതുരാകൃതിയിലുള്ള ഒ/്  ഐ ജക്റ്റ്  ഐ ഉണ്ടാക്കാന്‍

b) വൃത്താകൃതിയിലുള്ള ഒ/്  ഐ ജക്റ്റ്  ഐ ഉണ്ടാക്കാന്‍
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c) ഒബ് ജക്റ്റുകള്‍ ഫ്രെസലക്റ്റ് ഫ്രെചയ്യോന്‍ 

d) രചണ്ടാ അതിലധികച ാ വര്‍ണങ്ങള്‍ ലയിപ്പിക്കാന്‍

21) Synfig Studio യില്‍ ചലനം ക്ലാസ്  ഐ ആരം ക്ലാസ്  ഐഭിക്കുന്ന ടെnയി ിചനയും ക്ലാസ്  ഐ ചലനം ക്ലാസ്  ഐ അവസാനിക്കുന്ന 

ടെnയി ിചനയും ക്ലാസ്  ഐ ടെപാതുവായി പറയുന്ന ചപടെരന്ത്  ഐ ?

a) Tween Frames

b) Key Frames 

c) In between Frames

d) Frames Per Second

22) ചുവടെട നല്‍കിയിരിക്കുന്ന പ്രസ്താവനകളില്‍ നിന്നും ക്ലാസ്  ഐ Synfig Studio 

ചസാഫ്റ്റ്  ഐ ടെവയറിടെനക്കുറിച്ചുള്ള ശരിയായത്  ഐ തിരടെ�ടുക്കുക.

a) ത്രി ാന അനിച ഷന്‍ ചസാഫ്റ്റ്  ഐ ടെവയറാണ്  ഐ .

b) വിര്‍ച്വല്‍ ച�ാ/്  ഐ ചസാഫ്റ്റ്  ഐ ടെവയറാണ്  ഐ.

c) ഓഡിചയാ റിചക്കാര്‍ഡിങ്  ഐ ചസാഫ്റ്റ്  ഐ ടെവയറാണ്  ഐ.

d) ദ്വിമോന അനിപമഷന്‍ പസോഫ്റ്റ് ഫ്രെവയറോണ് . 

23) സിന്‍ഫിഗ്  ഐ സ്റ്റുഡിചയാ ചപാലുള്ള ചസാഫ്  ഐ റ്റ്  ഐ ടെവയറുകളില്‍ അനിച ഷന്‍ നിര്‍മ്മാണം ക്ലാസ്  ഐ 

എളുപ്പത്തിലാക്കാന്‍  ഉപചയാഗിക്കുന്ന Tweening സച?തം ക്ലാസ്  ഐ ഏത്  ഐ ഗണിത 

 സച?തത്തിടെ9 സഹായത്താലാണ്  ഐ സാധ്യ ാകുന്നത്  ഐ?

a) Squaring

• Interpolation

b) Maximizing

c) Factorization

24) Synfig Studio യില്‍ അനിച ഷന്‍ നിര്‍മ്മിക്കുചgാള്‍ Animate Editing Mode 

പ്രവര്‍ത്തനക്ഷ  ാചക്കണ്ടതിടെ9 അനിവാര്യ ായ ഘട്ടം ക്ലാസ്  ഐ ചുവടെട നല്‍കിയവയില്‍ 

ഏതാണ്  ഐ? 

a) അനിച ഷന്‍ പ്രവര്‍ത്തിപ്പിക്കുചgാള്‍

https://t.me/Shenibloggroup


b) കീടെnയിമുകള്‍ ഉള്‍ടെപ്പടുത്തുചgാള്‍

c) കീഫ്രെ�യിമുകളില്‍ ഒബ് ജക ് ടിഫ്രെ  സ്ഥോനം വ്യത്യോസഫ്രെ$ടുത്തുപDോള്‍  

d) അനിച ഷന്‍ എക്സ്  ഐചപാര്‍ട്ട്  ഐ ടെചയ്യുചgാള്‍

25) Synfig Studio ചസാഫ്റ്റ്  ഐ ടെവയറിടെല ഒരു ടൂളിടെ9 ചിത്ര ാണ്  ഐ നല്‍കിയിരിക്കുന്നത്  ഐ       

ഇതിടെ9 ഉപചയാഗടെ ന്ത്  ഐ?

a) ചതുരാകൃതിയിലുള്ള ഒ/്  ഐ ജക്റ്റ്  ഐ ഉണ്ടാക്കാന്‍

b) വൃത്തോകൃതിയിലുള്ള ഒബ് ജക്റ്റ് ഉണ്ടോക്കോന്‍

c) ചതുരാകൃതിയില്‍ ഒ/്  ഐ ജക്റ്റുകള്‍ ടെസലക്റ്റ്  ഐ ടെചയ്യാന്‍

d) രചണ്ടാ അതിലധികച ാ വര്‍ണങ്ങള്‍ ലയിപ്പിക്കാന്‍

SHORT ANSWER TYPE QUESTIONS

1) Synfig Studio ചസാഫ്  ഐ റ്റ്  ഐ ടെവയറിടെല ടൂള്‍ ച/ാക്സിലുള്ള രണ്ട്  ഐ ടൂളുകള്‍ ചുവടെട 
ടെകാടുത്തിരിക്കുന്നവയില്‍ നിന്നും ക്ലാസ്  ഐ തിരടെ�ടുക്കുക.

a) Star Tool

b) Transform Tool

c) Circle Tool

d) Smooth Move Tool

e) Gradient Tool

2)     ചുവടെട നല്‍കിയതില്‍ നിന്ന്  ഐ സ്വതന്ത്ര �്വി ാന അനിച ഷന്‍ ചസാഫ്റ്റ്  ഐ ടെവയറുകള്‍ 
തിരടെ�ടുക്കുക.

a) Toon Boon

b) Anime studio

c) Tupi: Open 2D Magic

d) Synfig Studio

e) Adobe Flash

3) Synfig Studio ടൂള്‍ ച/ാക്സിലുള്ള രണ്ട്  ഐ ടൂളുകള്‍ ചുവടെട ടെകാടുത്തവയില്‍ നിന്നും ക്ലാസ്  ഐ 
തിരടെ�ടുക്കുക.
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a) Star Tool

b) Edit paths by nodes

c) Draw bezier curves and straight lines

d) Gradient Tool

e) Draw calligraphic or strokes

4) അനിച ഷനു ായി /ന്ധമുള്ള ശരിയായ രണ്ട്  ഐ പ്രസ്താവനകള്‍ ടെതരടെ�ടുക്കുക.

a) Tupi: Open 2D Magic  ഒരു ദ്വിമോന അനിപമഷന്‍ പസോഫ്റ്റ് ഫ്രെവയറോണ്.

b) തുടര്‍ച്ചയോയും പവഗത്തിലും നിശ്ചലചിത്രങ്ങള്‍ ചലി$ിക്കുപDോഴോണ് 

അനിപമഷന്‍ നിര്‍മ്മിക്കഫ്രെ$ടുന്നത്.

c) Import ടെചയ്ത നിശ്ചല ചിത്രങ്ങള്‍ ടെകാണ്ട്  ഐ അനിച ഷന്‍ സാധിക്കില്ല. 

d) അനിച ഷന്‍ ടെചയ്യുചgാള്‍ ചലനചവഗത നിയന്ത്രിക്കാന്‍ സം ക്ലാസ്  ഐവിധാന ില്ല.

e) FPS അനിച ഷന്‍ ടെചയ്യുചgാള്‍ അപ്രസക്ത ാണ്  ഐ.

5) ചുവടെട നല്‍കിയിരിക്കുന്നവയില്‍ നിന്നും ക്ലാസ്  ഐ  Synfig Studio 

ചസാഫ്റ്റ്  ഐ ടെവയറിടെനക്കുറിച്ച്  ഐ ശരിയായ രണ്ട്  ഐ പ്രസ്താവനകള്‍ കടെണ്ടത്തുക.

a) ഇത്  ഐ ഒരു ഭൂവിവരവ്യവസ്ഥാ ചസാഫ്  ഐ റ്റ്  ഐ ടെവയറാണ്  ഐ.

b) ഇത്  ഐ ഒരു സ്വതന്ത്ര ത്രി ാനഅനിച ഷന്‍ ചസാഫ്റ്റ്  ഐ ടെവയറാണ്  ഐ.

c) ഇത് ഒരു സ്വതന്ത്ര ദ്വിമോന അനിപമഷന്‍ പസോഫ്റ്റ് ഫ്രെവയറോണ്.

d) പറോബര്‍ട്ട് ബി. ക്വോ(്ല്‍ബോം ആണ് ഇത് നിര്‍മിച്ചത്.

e) ടിം ക്ലാസ്  ഐ ച/ര്‍ചണഴ്  ഐ സ്  ഐ ലി  ആണ്  ഐ ഇത്  ഐ നിര്‍ ിച്ചത്  ഐ.

6) നക്ഷത്രങ്ങളുടെട ചലനം ക്ലാസ്  ഐ തയാറാക്കാന്‍ Synfig Studio ല്‍  വരച്ച ഒരു ചിത്ര ാണ്  ഐ 
മുകളിലുള്ളത്  ഐ . ചുവടെട നല്‍കിയിരിക്കുന്ന ഏടെതല്ലാം ക്ലാസ്  ഐ ടൂളുകളാണ്  ഐ ഇതിന്  ഐ  
ഉപചയാഗിച്ചിട്ടുണ്ടാവുക ?  

a) Circle Tool

b) Fill Tool

c) Text Tool

d) Star Tool
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e) Rectangle Tool

7)  Synfig Studio ചസാഫ്റ്റ്  ഐ ടെവയറിടെനക്കുറിച്ച്  ഐ ചുവടെട നല്‍കിയിട്ടുള്ള പ്രസ്താവനകളില്‍ 
 നിന്ന്  ഐ ശരിയായ രണ്ട്  ഐ പ്രസ്താവനകള്‍ തിരടെ�ടുക്കുക

a) Synfig Studio യില്‍ നിര്‍മ്മിച്ച അനിപമഷന്‍ ഫ്രെ,ോജക് ട് ഫയലോയി പസവ് ഫ്രെചയ്യോം.

b) Synfig Studio യില്‍ നിര്‍മ്മിച്ച അനിച ഷന്‍ ടെപ്രാജക്  ഐ ട്  ഐ ചിത്ര ഫയലായി  ാത്രച  
ചസവ്  ഐ ടെചയ്യാന്‍ സാധിക്കൂ.

c) Synfig Studio യില്‍ നിര്‍മ്മിച്ച അനിപമഷന്‍ ഫ്രെ,ോജക് ട് വീഡിപയോ ഫയലോയി 
എക്സ്പ�ോര്‍ട്ട് ഫ്രെചയ്യോം

d) Synfig Studio യില്‍ നിര്‍മ്മിച്ച അനിച ഷന്‍ ടെപ്രാജക്  ഐ ട്  ഐ വീഡിചയാ ഫയലായി 
എക്സ്  ഐചപാര്‍ട്ട്  ഐ ടെചയ്യാന്‍ സാധിക്കില്ല.

e) Synfig Studio യില്‍ നിര്‍മ്മിച്ച അനിച ഷന്‍ ടെപ്രാജക്  ഐ ട്  ഐ gif ഫയലായി  ാത്രച  
ചസവ്  ഐ ടെചയ്യാന്‍ സാധിക്കൂ.

8) Synfig Studio ഉപചയാഗിച്ച്  ഐ തയാക്കിയ രണ്ട്  ഐ തരം ക്ലാസ്  ഐ ഫയലുകളാണ്  ഐ  birds.sifz,

 birds.flv എന്നിവ. ഇതു ായി /ന്ധടെപ്പട്ട ശരിയായ രണ്ട്  ഐ പ്രസ്താവനകള്‍ താടെഴ 
ടെകാടുത്തിരിക്കുന്നവയില്‍ നിന്നും ക്ലാസ്  ഐ കടെണ്ടത്തുക

a) Synfig Studio പസോഫ് (് ഫ്രെവ യറു�പയോഗിച്ച്  തയ്യോറോക്കിയ ഫ്രെ,ോജക് ട് ഫയലോണ്  

birds.sifz

b) pdf ആയി എക്സ്  ഐചപാര്‍ട്ട്  ഐ ടെചയ്തതാണ്  ഐ  birds.sifz

c) വീഡിചയാ ഫയലായി എക്സ്  ഐചപാര്‍ട്ട്  ഐ ടെചയ്തതാണ്  ഐ birds.sifz

d) വീഡിചയാ ഫയലായി എക്സ്  ഐചപാര്‍ട്ട്  ഐ ടെചയ്തതാണ്  ഐ birds.flv

e) Synfig Studio പസോഫ് (് ഫ്രെവ യറു�ഫ്രെയഗിച്ച്  തയ്യോറോക്കിയ ഫ്രെ,ോജക് ട് ഫയലോണ്  

birds.flv

9) Synfig Studio ല്‍ ടെലയറുകടെള സം ക്ലാസ്  ഐ/ന്ധിച്ച്  ഐ ചുവടെട നല്‍കിയിരിക്കുന്നവയില്‍ 

 നിന്ന്  ഐ ശരിയായ പ്രസ്താവനകള്‍ തിരടെ�ടുക്കുക. 

a) ടെലയറുകള്‍ പ്ര�ര്‍ശിപ്പിക്കുന്നത്  ഐ ടൈടം ക്ലാസ്  ഐട്രാക്  ഐ പാനലിലാണ്  ഐ .

b) പാനലിലുള്ള ടെലയറുകളുടെട ക്ര ം ക്ലാസ്  ഐ  ാറ്റാന്‍ സാധിക്കില്ല .

c) പുതിയ ടെലയറുകള്‍ നിര്‍ ിക്കാന്‍ സാധിക്കില്ല .
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d) �ോനലിലുള്ള ഫ്രെലയറുകളുഫ്രെട ക്രമം മോ(ോന്‍ സോധിക്കും .

e) �ോനലിലുള്ള ഫ്രെലയറുകഫ്രെള ആവശ്യോനുസരണം ഗ്രൂ$് ഫ്രെചയ്യോന്‍ സോധിക്കും .

10) Synfig Studio യിടെല Layer ടെന സം ക്ലാസ്  ഐ/ന്ധിച്ച ശരിയായ രണ്ട്  ഐ 
പ്രസ്താവനകള്‍ ചുവടെട നല്‍കിയവയില്‍ നിന്നും ക്ലാസ്  ഐ തിരടെ�ടുക്കുക.?

a) ഉള്‍ഫ്രെ$ടുത്തുന്ന എല്ലോ  Object കളും വ്യത്യസ്ത ഫ്രെലയറുകളില്‍ ആയിരിക്കും.

b) ഉള്‍ടെപ്പടുത്തുന്ന എല്ലാ  Object കളും ക്ലാസ്  ഐ ഒരു ടെലയറില്‍ തടെന്ന ആയിരിക്കും ക്ലാസ്  ഐ.

c) ഒരു Object ഫ്രെന ഒഴിവോക്കുപDോള്‍ ആ ഒബ് ജക് ട് ഉള്‍ഫ്രെ$ടുന്ന  ഫ്രെലയര്‍ മോത്രം 

നഷ്ടഫ്രെ$ടുന്നു.

d) ഏടെത?ിലും ക്ലാസ്  ഐ ഒരു  Object ടെന ഒഴിവാക്കുചgാള്‍ എല്ലാ ടെലയറുകളും ക്ലാസ്  ഐ നഷ്ടടെപ്പടുന്നു.

e) Preview കാണുചgാള്‍ ഒരു ടെലയര്‍  ാത്രച  ദൃശ്യ ാവൂ.
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STANDARD 10

CHAPTER : 10 കമ്പ്യൂട്ടറിന്റെ പ്രവര്‍ത്തകസംവിധാനം

1) കമ്പ്യൂട്ടറിന്റെ പിതാവ് എന്നറിയപ്പെടുന്നതാര് ?

A അഡ ബൈറണ്‍

B ചാള്‍സ് ബാബേജ്

C കെന്‍ തോംസണ്‍

D ഡെന്നീസ് റിച്ചി

2) ചാള്‍സ് ബാബേജ് രൂപകല്പന ചെയ്ത അനലിറ്റിക് എഞ്ചിനെ ആദ്യ കമ്പ്യൂട്ടര്‍ എന്ന് 
വിളിക്കാന്‍ കാരണമെന്ത് ?

A ആധുനിക കമ്പ്യൂട്ടറിന്റെ ഘടനയുമായി സാമ്യമുള്ളതിനാല്‍
B ആധുനിക കമ്പ്യൂട്ടറിന്റെ രൂപവുമായിസാമ്യമുള്ളതിനാല്‍
C ആധുനിക കമ്പ്യൂട്ടറിന്റെ അടിസ്ഥാനാശയങ്ങള്‍ ഇതിനുവേണ്ടിയും വിഭാവനം

ചെയ്യപ്പെട്ടതിനാല്‍
D ആധുനിക കമ്പ്യൂട്ടറിന്റെ ഓപറേറ്റിങ്ങ് സിസ്റ്റവും പ്രോഗ്രാമുകളും ഉള്ളതിനാല്‍

3) റിച്ചാര്‍ഡ് സ്റ്റാള്‍മാന്‍ നേതൃത്വം കൊടുത്ത ഗ്നു (GNU) പ്രോജക്റ്റ് ഒരു ഓപ്പറേറ്റിങ് സിസ്റ്റം നിര്‍
മിക്കാനാരംഭിച്ചപ്പോള്‍ താഴെ കൊടുത്തിരിക്കുന്നവയില്‍ ഏതിനെയാണ് മാതൃകയാക്കിയത്  

A Linux  B Unix  C BSD D Debian

4) ഗ്നു /ലിനക്സ് ഓപറേറ്റിങ് സിസ്റ്റം പ്രവര്‍ത്തിക്കുന്ന കമ്പ്യൂട്ടറുകളില്‍ ഫയലുകള്‍ താല്‍
ക്കാലികമായി സൂക്ഷിക്കുന്നതിനായി തയ്യാറാക്കുന്ന ഒരു അതിവേഗ ഫയല്‍ സിസ്റ്റം ഏതാണ്
?

A റൂട്ട്  (/)

B ഹോം (/home)

C സ്വാപ്   (swap)  
D റാം (RAM)

C സ്വാപ് (swap)

5) ഗ്‌നു /ലിനക്സിനെ സംബന്ധിച്ച് താഴെ പറയുന്നവയില്‍ ഏറ്റവും ശരിയായ പ്രസ്താവന 
ഏതാണ് ?



A ഇത് ഒരു സ്വതന്ത്ര ഓപറേറ്റിങ്ങ് സിസ്റ്റമാണ്  .  

B ഇത് പൂര്‍ണമായും ലിനസ് ടോര്‍വാള്‍ഡ്സ് നിര്‍മിച്ചതാണ്.

C ഇതിന്റെ പ്രധാന ഭാഗങ്ങളെല്ലാം റിച്ചാര്‍ഡ് സ്റ്റാള്‍മാന്‍ നിര്‍മിച്ചതാണ്.

D ഇതിന്റെ പ്രധാന ഭാഗങ്ങളെല്ലാം ഡെന്നീസ് റിച്ചി നിര്‍മിച്ചതാണ്.

6) ഗ്‌നു / ലിനക്‌സ് ഓപ്പറേറ്റിങ് സിസ്റ്റത്തിന്റെ കേര്‍ണല്‍ പ്രോഗ്രാം ഏതാണ് ?

A ഗ്‌നു

B ലിനക്‌സ്

C യുനിക്സ്

D റൂട്ട് (/)

7)  കമ്പ്യൂട്ടറിന്റെ ഹാര്‍ഡ്‍വെയറുമായി നേരിട്ടോ ഡ്രൈവറുകളുടെ സഹായത്തോടെയോ 

സംവദിക്കുന്ന ഓപ്പറേറ്റിങ് സിസ്റ്റത്തിന്റെ ഭാഗത്തിനെ വിളിക്കുന്ന പേരെന്താണ് ?

A ഷെല്‍

B കമാന്റ് 

C കേര്‍ണല്‍

D GUI

8)ചുവടെ നല്‍കിയിട്ടുള്ളവയില്‍ സമ്പൂര്‍ണമായ ഓപ്പറേറ്റിങ് സിസ്റ്റം അല്ലാത്തതേതാണ് ?

A യൂനിക്സ് (Unix)

B BSD (Berkeley Software Distribution)

C മാക് ഓഎസ്  X (Mac OS X)

D ഗ്‌നു ഹെര്‍ഡ്   (GNU HURD)   

9) താഴെ പറയുന്നവരില്‍ ആരാണ് യുനിക്സ് എന്ന ഓപറേറ്റിങ് സിസ്റ്റത്തിന്റെ നിര്‍മാണത്തില്‍ 
പങ്കാളിയായിരുന്നത് ?

A ഡെന്നീസ് റിച്ചിയും കെന്‍ തോംസണും

B കെന്‍ തോംസണും റിച്ചാര്‍ഡ് സ്റ്റാള്‍മാനും

C റിച്ചാര്‍ഡ് സ്റ്റാള്‍മാനും ഡെന്നീസ് റിച്ചിയും

D കെന്‍ തോംസണ്‍, ഡെന്നീസ് റിച്ചി,

റിച്ചാര്‍ഡ് സ്റ്റാള്‍മാന്‍ എന്നിവര്‍



10) ഇന്ന് കാണുന്ന പല ഓപ്പറേറ്റിങ് സിസ്റ്റങ്ങളും ചുവടെ നല്‍കിയിട്ടുള്ള ഒരു ഓപ്പറേറ്റിങ് 
സിസ്റ്റത്തില്‍ നിന്ന് വികസിപ്പിച്ചെടുത്തവയോ അല്ലങ്കില്‍ അതിനെ മാതൃകയാക്കി 
പുനഃസൃഷ്ടിച്ചവയോ ആണ്. ഏതാണ് ആ ഓപ്പറേറ്റിങ് സിസ്റ്റം ?

A വിന്‍ഡോസ്

B മാക് ഓഎസ്  X

C യുനിക്സ്

D BSD

11) കമ്പ്യൂട്ടറിലെ ഏത് ഹാര്‍ഡ്‌വെയര്‍ ഘടകവും പ്രവര്‍ത്തിക്കണമെങ്കില്‍ അത് എങ്ങനെ 

പ്രവര്‍ത്ത‌ിക്കണം എന്ന് നിര്‍ദ്ദേശിക്കുന്ന ഒരു  പ്രോഗ്രാം കൂടെയുണ്ടാകണം. ഈ പ്രോഗ്രാമിന‌െ 

താഴെ പറയുന്നവയില്‍ ഏതു പേരിലാണ് വിളിക്കുന്നത് ?

A ഡ്രൈവര്‍

B ടെര്‍മിനല്‍

C കേര്‍ണല്‍

D ഷെല്‍

12) ഹാര്‍ഡ് ഡിസ്കിനെ പല ബ്ലോക്കുകളായി തിരിച്ച് ഫയല്‍ സിസ്റ്റം നിര്‍മിക്കുന്ന പ്രക്രിയ 
ചുവടെ നല്‍കിയവയില്‍ ഏത് പേരില്‍ അറിയപ്പെടുന്നു ?

A കമാന്റിങ്

B ഇന്‍സ്റ്റലേഷന്‍

C എഡിറ്റിങ്

D ഫോര്‍മാറ്റിങ്

13) ഓരോ ഓപ്പറേറ്റിങ് സിസ്റ്റവും അതിനു യോജിച്ച രീതിയില്‍ ഹാര്‍ഡ് ഡിസ്കിനെ ഫോര്‍മാറ്റ് 
ചെയ്തിരിക്കുന്നതിനെ അതാതിന്റെ …………………….എന്നു വിളിക്കുന്നു. വിട്ടുപോയ ഭാഗത്തിന് 
അനുയോജ്യമായവ ചുവടെ നിന്ന് തിരഞ്ഞെടുക്കുക.

A ഷെല്‍

B ഫയല്‍ സിസ്റ്റം 

C കമാന്റ് 

D കേര്‍ണല്‍

14) NTFS എന്ന ഫയല്‍ സിസ്റ്റം ചുവടെ നല്‍കിയിട്ടുള്ള ഏത് ഓപ്പറേറ്റിങ് 
സിസ്റ്റത്തിനാണ് ഏറ്റവും അനുയോജ്യമായത് ?



A ഗ്‌നു / ലിനക്സ്

B മൈക്രോസോഫ്റ്റ് വിന്‍ഡോസ്

C ആപ്പിള്‍ മാക് ഓഎസ്  X

D യുനിക്‌സ്

15) താഴെ പറയുന്നവയില്‍ ഒരു സ്മാര്‍ട്ട് ഫോണ്‍ ഓപറേറ്റിങ്ങ് സിസ്റ്റം ലിനക്സ്
അടിസ്ഥാനമാക്കി തയ്യാറാക്കിയിട്ടുള്ളതാണ്. അത് ഏതാണ് ?

A ആന്‍ഡ്രോയ്ഡ്

B ബ്ലാക്ക്ബെറി 10

C iOS

D Symbian

16) ഒരു കമ്പ്യൂട്ടറിന്റെ ഹാര്‍ഡ്‌ഡിസ്ക് പാര്‍ട്ടീഷനെക്കുറിച്ചുള്ള വിവരങ്ങള്‍ കണ്ടെത്തുന്നതിന് 

ഉപയോഗിക്കാവുന്ന സോഫ്റ്റ്‌വെയര്‍ ചുവടെ കൊടുത്തിട്ടുള്ളവയില്‍ ഏതാണ് ?

A Gnu Hurd

B Disks (gnome-disks)

C KompoZer

D MySQL

B Disks (gnome-disks)

17) ചുവടെ കൊടുത്തിട്ടുള്ളതില്‍ ഏത് ഓപ്പറേറ്റിങ് സിസ്റ്റമാണ് XNU എന്ന കേര്‍ണല്‍ 

ഉപയോഗിക്കുന്നത് ?

A ഗ്‌നു / ലിനക്സ്

B വിന്‍ഡോസ്  NT

C ആപ്പിള്‍ മാക്    OS X  

D  BSD

18)  കുത്തകാവകാശ സോഫ്റ്റ്‌വെയറുകളെ സംബന്ധിച്ച് ചുവടെ കൊടുത്തിട്ടുള്ള 

പ്രസ്താവനകളില്‍  ഏതാണ് സാധാരണഗതിയില്‍ ശരിയാവുക ‍?

A ഉപയോക്താവിന് സൗജന്യമായി ലഭ്യമാക്കും.

B ഉപയോക്താവിന് സോഴ്‌സ്‌കോഡ് ലഭ്യമാക്കും.

C ഉപയോക്താവിന് ഒബ്‌ജക്‌ട് കോഡ് മാത്രം ലഭ്യമാക്കും  .  

D ഉപയോക്താവിന് സോഴ്‌സ്‌കോഡും ഒബ്‌ജക്ട് കോഡും ലഭ്യമാക്കും.



19) സ്വതന്ത്ര സോഫ്റ്റ്‌വെയറുകളെ സംബന്ധിച്ച് ചുവടെ കൊടുത്തിരിക്കുന്നവയില്‍ 

അനുയോജ്യമായ പ്രസ്‌താവന ഏത് ?

A ഉപയോക്താവിന് സോഴ്‌സ്‌കോഡ് മാത്രം ലഭ്യമാക്കും

B ഉപയോക്താവിന് ഒബ്‌ജക്‌ട് കോഡ് മാത്രം ലഭ്യമാക്കും.

C ഉപയോക്താവിന് സോഴ്‌സ് ‌കോഡും ഒബ്‌ജക്‌ട് കോഡും ലഭ്യമാക്കും

D ഉപയോക്താവിന് സോഴ്‌സ് ‌കോഡും ഒബ്‌ജക്‌ട് കോഡും ലഭ്യമാക്കില്ല.

20) താഴെ പറയുന്നവയില്‍ ഏതാണ് വിയറബ്ള്‍ ഡിവൈസുകള്‍ക്ക് (Wearable Devices) 

ഉദാഹരണമല്ലാത്തത് ?

A സ്‌മാര്‍ട്ട് വാച്ചുകള്‍

B ശരീരത്തിനകത്ത് ഘടിപ്പിച്ച ഇന്‍സുലിന്‍

പമ്പുകള്‍

C കാമറയും സെന്‍സറുമുള്ള ലോക്കറ്റുകള്‍

D മൊബൈല്‍ ഫോണുകള്‍
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